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Introduction to Title Composer 
 
The Title Composer is used to create title pages.  Of course you knew that or you wouldn't have purchased the program.  The best part of 
Title Composer is how those titles can be used.  You can title over existing graphics or key the titles over an external video source. 
 
You can title over your existing graphics by loading the graphic as a background image and adding the title to it.  Once this is done, the 
titled graphic image can be exported to the Clipboard, or it can be saved back to the disk in a standard graphics format. 
 
The title pages can contain text (of course), background color boxes, geometric shapes, full-color graphic images as logos, and either a 
background graphic or background video. 
 
The text can be created using TrueType typefaces and can be sized, rotated, and italicized.  Each character can have up to two edges and 
three shadows.  The character’s edges and shadows can be colorized with either a solid color, a vertical color spread, a color gradient (4pt, 
5pt, or linear), or with a texture. 
 
Background color boxes can be created any size and position on the screen.  They can be colorized with all of the same color options as the 
characters, they can even be made semi transparent. 
 
Geometric shapes can be created at any size and position on the screen.  The roundness of the shape can be controlled.  The shape can be 
made square, completely round (as a circle or ellipse), or anywhere in between.  Shapes can be sized, rotated, italicized, edged, and colorized 
just like any other character. 
 
Standard graphic format graphics can be loaded as either full-color logos or as a background image.  When graphic images are loaded as 
logos, they can be sized, edged, and positioned anywhere on the screen. 

Chapter 

1
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Title Composer User Interface 
If you don't have the software installed yet, follow the directions in chapter 1. 
 
Start the Title Composer just like you would any other program under Windows.  After a few seconds the program’s user interface will 
appear.  The software automatically adjusts its’ windows to fit your screen.  If your screen resolution is set to 1024 by 768, it will appear 
similar to the one shown below. 
 

 
Screen appearance on a 1024 by 768 VGA screen. 

 
Menus 
The menu (shown below) is just what you would expect in a Windows program.  It has a “File” entry that is used to open, create, and save, 
the types of files that Title Composer can open, create, and save (pages, templates, and projects).  It has an “Edit” entry that is used for the 
normal Undo, Cut, Copy, Paste, Insert, Delete, and Erase functions. 
 

 
Title Composer menu. 
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The “View” menu is used to display or hide the various windows. 
 
The “Attributes” menu is used to adjust the various text attributes. 
 
The “Move Text” menu has commands for Word Wrap/Unwrap, Centering, Justifying, and Positioning.  It also has a command to let you 
adjust the Row Leading. 
 
The “Layers” Menu is used to change the layering priority (move one in front of another). 
 
The “Settings” menu is used to setup your system.  These include things like Setting User Preferences, Loading Typefaces, Setting Tabs, 
Adjusting Safetitle Margins, set the page to Lower Third mode, and setting your default folders/directories. 
 
If Text FX is supported on your system, there will be a Text F/X menu.  The “Text FX” menu launches the Text FX editor.  This allows 
the system to independently animate each layer. 
 
The Help Menu is for learning more about how to use the program. 
 
Toolbar 

 
Title Composer Toolbar 

 
The Toolbar (shown above) is a quick way to access common functions.  These include commands from the File menu such as Create New 
Page, Open Existing Page, and Save page.  Check Spelling, cut, copy, paste, and undo functions from the Edit menu are included on the 
toolbar. 
 
The toolbar contains a mode selection box that defaults to "Selected Text".  This determines which text will be affected when Character 
Attributes (font, size, edge, color, etc.) are changed or when text is repositioned.  The options include such things are Selected text, entire 
word, entire row, entire layer, and entire page. 
 
To the right of the mode selection box are some buttons that Center and Justify the current layer.  There are even buttons to change the 
priority of the current layer (move one in front of another). 
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Project Manager 

 
Project Manager. 

 
The project manager (Shown above) keeps the settings and pages from different projects separate from one another.  It also gives you quick 
access to all of the pages in the project.  The top of the Project Manager displays the name of the current project. 
 
When a Page is saved, a "PICON" is created which is a miniature image of the page.  These Picons, along with the name of each page in the 
project is displayed in the Project Manager.  To open a page, just click on its PICON. 
Title Compose Window 
The Title Compose window is where you compose your title pages.  To enter text in this window, point the mouse to where you want the 
text to appear, and click the left mouse button.  A rectangle will appear where you clicked the mouse.  This is the text cursor.  It shows 
where text will be entered.  Type some text and it will appear at the cursor position. 
 
Shortcut Buttons 
The Shortcut Buttons window contains buttons of frequently used functions.  They are placed in this handy position so that you can just 
reach over and easily press one of these buttons with the mouse. 
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Preset Style Gallery 
Each project can have up to 64 preset text styles.  These are text styles that you may want to use frequently.  You're not limited to only 
these 64 styles, they are only there as shortcut to the styles that you use most often.  You can scroll through the preset text styles, and select 
one by clicking on it.  When you select a new style from the Style Gallery, all selected text will be set to the new style.  You can change these 
preset text styles to be whatever you want. 
 
Page Template Gallery 
Many users like to have a common look to their titles.  Whether it is for their entire facility, or a unique "look" for each client.  With Title 
Composer you can create a Page Template of the desired page style with "Template Fields" at different positions on the page.  When the 
Page Template is opened, a window appears that prompts the user to enter the text for each field.  Once the text is entered, the page is 
automatically created using the style of the Template and the text that was entered in the Template Fields. 
 
Controls Tabs 
The Title Composer gives you a lot of control over the appearance of the characters.  So much so, that all of the controls required to set all 
of the different parameters that can be controlled, would not fit on your screen at one time.  So we have divided them up into groups and 
placed each group of controls on its’ own separate tabbed box.  We then took each box of controls and placed them all in a single window 
with tabs to select which group of controls that you want to use. 
 
Character Tab 

 
 
The Character Tab is used to change the Height, Width, Italics angle, Rotation, Kerning, and Blur of the character.  It is also used to select 
the Typeface for the text.  Clicking and dragging the cursor handles can also change the text size, position, italics angle, and rotation.  You 
can turn the handles on and off.  So they only appear when you want to use them.   
 



C H A P T E R  1  –  I N T R O D U C T I O N  T O  T I T L E  C O M P O S E R  
 

 6

Any of the values represented by icons (Height, Width, Italics, Rotation, Kerning, and Blur) can be modified by clicking on the appropriate 
icon and dragging the mouse.  The text will be redrawn with the new values as you drag the mouse. 
 
Edges Tab 

 
 
Each character can have 2 edges.  You can select from the following:  
 

This edge does not appear 
 

The edge surrounds the character equally on all sides 
 
The character is extruded to give the character a 3D look 
 
The character is extruded with a narrow full surround border to highlight the character  
 
The edge is offset as if it is casting a shadow.   
 
The depth and blur of each edge can be set separately.  If the selected edge type is Extruded, Highlighted, or Offset, the 

direction can be set to any of the 8 directions.   
 
Both edge work identically.  Edge 1 appears in front of Edge 2.   
 
Clicking on the "Depth" icon and dragging the mouse will change the edge depth.  Clicking on the "Blur" icon and dragging the mouse will 
change the edge blur.  The text will be redrawn with the new values as you drag the mouse.   
 

No Edge 

Full Surround 

Extruded 

Highlighted 

Offset 
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Shadows Tab 

 
 
Each character can have up to 3 shadows in addition to the 2 edges.  The shape of each shadow can be set to be the same shape as the 
Character, Edge 1, or Edge 2.  All 3 sets of shadow controls work the same. 
 
Each component of the character (Character, Edges, and Shadows) stack up in the following order:  
 
CHARACTER  
SHADOW 1  
EDGE 1  
SHADOW 2  
EDGE 2  
SHADOW 3  
 
Shadow 1 is between the Character and Edge 1, Shadow 2 is between Edge 1 and Edge 2, and Shadow 3 is behind Edge 2.   
 
The position of each shadow can be independently varied in single pixel increments.  They can be offset from the character by as much as 
100 pixels in any direction.  Clicking on the "Offset" icon and dragging the mouse will move the shadow in relationship to the character.   
 
The color of each shadow can be set independently.  It can be set to any color (including a Gradient or a Texture) just like the characters 
and edges. 
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Colors Tab 

 
 
The Colors Tab is used to change the color of the Character, both Edges, and all 3 of the Shadows.  On the left there is a group of boxes 
that display the current color of each component of the character.  The box below it shows the color of the component that is currently 
selected.   
 
To change the color, select the component to change (Character, Edge, or Shadow) then use the controls on the right to select the color.  
There are five ways to select a color.  You can use a color picker, color sliders, select a color from a preset palette, set the color to a 
gradient, or set the color to a texture.   
 
Press one of the 5 buttons to select which method you want to use to select the color.   
 
There are 5 different methods you can use to select colors, these are: 
 
Color Picker 
Color Sliders 
Color Palette 
Color Gradients 
Textures 
 

C O L O R  P I C K E R  
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The color picker lets you select a color using a visual approach.  You can set the top and bottom colors separately.  If the top and bottom 
colors are different, the Character, Edge, or Shadow will be drawn with a smooth color spread between the top and bottom.  One of the 
controls in this box is used to select the Hue (red, yellow, green, blue, etc) of the color.  When a new hue is selected the other color box will 
change to reflect the new hue.  You can select any color from this box just by clicking the mouse on the desired color.   
 
You can also vary the Transparency and the amount of External video levels that the text component will be drawn with.  Transparency will 
let whatever is behind the component to show through.  Setting the Video Level draws the component with a mixture of background video 
and a color.  The higher the video level, the more dominant the background video will appear.   
 
The "Illegal Color Indicator" will appear red if the selected color is an illegal NTSC or PAL color.  It will appear green if a legal color is 
selected.   
 

C O L O R  S L I D E R S   

 
 
The color sliders let you select the color using a numerical approach.  You can choose whether you want to define RGB (red, green, blue) 
values or HLS (Hue, Luminance, Saturation) values.  The top and bottom colors can be set separately.  If the top and bottom colors are 
different, the Character, Edge, or Shadow will be drawn with a smooth color spread between them.   
 
You can also vary the Transparency and the amount of External video levels that the text component will be drawn with.  Transparency will 
let whatever is behind the component show through.  Setting the Video Level draws the component with a mixture of background video 
and a color.  The higher the video level, the more dominant the background video will appear.   
 
The "Illegal Color Indicator" will appear red if the selected color is an illegal NTSC or PAL color.  It will appear green if a legal color is 
selected.   
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C O L O R  P A L E T T E   

 
 
You can select from any of the 64 preset colors from the color Palette.  The top and bottom colors can be set separately.  If the top and 
bottom colors are different, the Character, Edge, or Shadow will be drawn with a smooth color spread between them.   
 
The "Illegal Color Indicator" will appear red if the selected color is an illegal NTSC or PAL color.  It will appear green if a legal color is 
selected.   
 
You can also select Background Video as the color just by pressing the "Background Video" button.  To modify the color palette, double 
click on the entry that you want to modify.  The Color Palette Editor will appear.  This lets you change the color of each palette entry.   
 

C O L O R  G R A D I E N T S   

 
 
Each project in the Title Composer can have as many as 64 preset color gradients defined.  They can be either linear gradients or area 
gradients.  A Linear Gradient can have up to 16 color points and can be rotated up to 90 degrees in either direction.  An area gradient can 
set each corner to a different color and the colors will create a smooth blend between the colors.  A center color point can also be added to 
create a 5-point color gradient.  The center point can be positioned anywhere within the color gradient.  This is very useful for creating 
Highlighted colors.   
 
You can modify a color gradient by double clicking on the one you want to modify.  The Color Gradient Builder will then appear.  The 
Color Gradient Builder can then be used to select the type of gradient, as well as the color and position of the points in the gradient.   
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C O L O R  T E X T U R E S  

 
 
The Textures button lets you apply a texture to any of the text components (Character, Edges, or Shadows).  Select any of the loaded 
textures by clicking the mouse on the desired texture.  There can be up to 16 textures loaded for each page.  GIF, TIF, TGA, BMP, PCX, 
JPG, or JPEG image can be used as textures.  To load a new texture, double click on the position that you want to load it into then select 
the image that you want to load as the new texture. 
 
Layers Tab 

 
 
Title Composer can place text on multiple layers.  Up to 1000 layers can be used on each page.  These layers are completely independent of 
each other.  Changing something on one layer will not affect the text on the other layers.  Each layer can be assigned a unique name.  The 
"Layering Order" list shows the current order of the layers.  The Top layer in the list is the front layer of the page.  A layer is in front of all 
of the layers that are listed below it in the layering list, and behind all of the layers that are listed above it.  Each layer can be moved in front 
of, or behind the other layers.  This is done by using the buttons to move the layer to the top layer, Up 1 Layer, Down 1 Layer, or to the 
bottom layer.  The order of the layers can also be changed by dragging it from its current position to the new position in the "Layering 
Order" list.   
 
Individual layers can be hidden so that they do not cover the lower layers that you are working on.   
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To create a new layer, press and hold down the <Ctrl> key, then click the left mouse button where you want the new layer to appear on the 
screen.   
 
Positioning Tab 

 
 
The Positioning tab has the buttons that are used to Wrap and Unwrap words, Centering, and Justifying rows, entire layers, and entire 
pages.  The text can also be fine positioned by using "Fine Positioning" buttons.   
 
The text can also be positioned by dragging the Cursor Handles with the mouse, or by holding down the right mouse button and dragging 
the selected text to the desired position. 
 
Row Spacing Tab 

 
 
These controls are used to change the row leading (spacing) of the cursor row, the entire Layer, or the Entire page.   
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Shapes Tab 

 
 
Shapes are boxes that you can control the roundness and aspect ratio of.  Once a shape has been placed on the page you can size it, colorize 
it, add edges and shadows to it, and even rotate it.  In fact you can do anything to a shape that you can do to a character (except change its’ 
typeface of course).  A foreground shape gets inserted into the current layer at the cursor position.  A background shape gets added to a 
new layer that is behind the currently selected text. 
 
The aspect ratio of the shape can be changed from tall and skinny to very wide.  The roundness of the shape can be set to any value from 0 
to 100%.  A roundness of 0% creates a shape that has square corners.  A roundness of 100% creates a shape that is either a circle or an 
ellipse (depending on aspect ratio).  A value between 1 and 99% creates a box that has rounded corners.  The amount that the corners are 
rounded is determined by the roundness setting.   
 
Logos Tab 

 
 
Full color logos may be added to the page.  As many as 16 different logos can be added to a page.  The logos can be loaded directly from 
GIF, TIF, TGA, BMP, PCX, JPG, or JPEG images.  If the selected logo image includes an alpha channel, the alpha channel is supported. 
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When you Press the "Add New Logo" button, a window appears that allows you to select the logo image that you want to place on the 
page.  Once a logo is placed you can size and edge it just like you would a character.   
 
Background - Image Tab 

 
 
There are two types of backgrounds that can be added to the pages.  A background graphic, or background colors.  A GIF, TIF, TGA, 
BMP, PCX, JPG, or JPEG image can be loaded as the background Graphic.  If the background Graphic includes an alpha channel, the 
alpha channel is supported.   
 
A background graphic can be displayed Full screen, Original Size, or Tiled.  When a background graphic is loaded as Full screen the graphic 
is scaled so that it appears full screen.  When a background graphic is loaded in its original size, it will not be scaled.  A set of buttons will 
appear to allow you to position the background graphic on the page.  Tiling a background graphic that is smaller than the screen will repeat 
the graphic horizontally and vertically to fill up the entire page.   
 
If you select the "No Graphic" button, no background graphic will appear.  The background video will be displayed as the background.   
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Background - Colors Tab 

 
 
Background color boxes can be added to the page.  You can apply a solid color (with transparency and Background video) or you can apply 
a color gradient (linear, 4 point, or 5 point).  You can even apply a texture to a background color box.   
 
As many as 32 color boxes can be placed on each page.  The layering order of background color boxes can be changed.   
 
Text Substitution Tab 

 
 
The Text Substitution Tab is used to control the Text Substitution Variables and the Template Fields on a page. 
 
Text Substitution variables are used to display data that may change from time to time.  These can be things like Temperature, Vote Counts, 
Sports Scores, or any other data that you may want to automatically update.  To enable this feature you must have an optional plug in that 
may be purchased from Datavideo, Third Party Vendors, or you can write your own. 
 
Template Fields are used when creating Template pages.  This is the text that the user will be prompted for when a Template Page is used 
to create a Title Page. 
 



C H A P T E R  1  –  I N T R O D U C T I O N  T O  T I T L E  C O M P O S E R  
 

 16

Page Transition Tab 

 
 
The Page Transition Tab is used to select the Display Transition to use when the page is displayed.  It also sets the speed of the transition 
(Transition Duration) and how the long page will display when auto-sequencing. 
 
Status Bar 

 
 
The Status Bar (shown above) at the bottom of the screen displays the current status of the program.  It is divided into 6 panes.  The first 
pane displays a one line HINT about the Toolbar button or Menu entry that the cursor is currently pointing to.  The next pane shows the 
current Mouse position.  The third pane shows the current Cursor Position.  The fourth pane shows the name of the current layer.  The 
fifth pane shows the current typing mode (insert or overwrite).  The last pane displays the current row and column position of the cursor 
within the layer 
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Editing Text 
 
The easiest way to learn how to use the Title Composer is to use it.  In this manual we will create some pages.  They may not always be 
pretty, but they will demonstrate how to do the various functions that the Title Composer has to offer. 
 
Create a New Project 
Before we begin creating pages with the Title Composer, let’s create a new project for the pages.  Selecting the “New Project” command 
from the “File” menu does this.  When this is done a window like the one below will appear. 
 

 
 
Let’s call our project TUTORIAL. Enter the name of the new project where it says “New Project Name” and press the “Create” button.  
The name of the new Project now appears at the top of the project manager. Since we haven’t created any pages for the new project yet, no 
pages appear in the list.  During this tutorial we will create pages for the TUTORIAL project. 
 
Create New Page 
Create a new page by selecting the “New Page” command from the “File” menu. This could also be done by pressing the first button on 
the Toolbar.  If you have modified text on the current page (and “Always Ask First” is selected under “Automatically Save Pages” in the 
“User Preferences”), a window like the one below will appear. 
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2



C H A P T E R  2  -  E D I T I N G  T E X T  
 

 18

 
 
This reminds you to save any changes to the page before you create the new page. Once you have selected “Yes” or “No”, a warning 
message (shown below) will appear warning you that the current page is about to be erased.  
 

 
 
If you press the “No” button the “New Page” command will be canceled.  If you press the “Yes” button the page will be erased and you 
will be asked which type of page you would like to create by a window like the one shown. 
 

 
 
You can chose between 3 different types of pages, Still, Roll, and Crawl.  Some systems may not support rolls and crawls.  If your system 
does not, the appropriate buttons will be disabled.  Create a “Still” page by pressing the “Still” button.  This will create a new page that is 
blank. 
 
Title Compose Window 
The Title Compose window is where you compose your pages. This window displays the title graphic that you are working on as you 
compose it.  If this window is smaller than the actual title graphic that you are creating, the title graphic will be scaled to fit this window.  If 
the title graphic is too small to see, try one of the following: 
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Maximize the Title Composer window. 
 
Use a higher resolution VGA mode (i.e. 1024 by 768). 
 
Use the View menu to turn off other Title Composer windows to make more room for the Title Compose Window. 
 
Select the View Title Full Size command from the View menu to make the title compose window full size. 
 
Typing Text 
To enter text in this window, point the mouse to where you want the text to appear, and press the left button. A rectangle appears where 
you clicked the mouse. This is the text cursor. It shows where text will be entered.  Now type the message “I Really like the Title 
Composer”, the text will appear on the VGA screen as you type it. If you are running on a system that has a separate video output, you will 
notice that the text also appears on that screen. 
 
If the text is too big to fit on the screen, select a smaller text style from the Style Gallery (on the right side of the screen) and throw away 
the page with the big characters by creating a new page again. Then re-type the message “I Really like the Title Composer” with the 
smaller text style. 
 
Moving the Cursor 
You can use the cursor movement keys to move the cursor around in this window, or you can use the mouse to point to where you want 
the cursor to be placed and click the left button. The Arrow keys move the cursor one character or row in the direction of the arrow. The 
<Home> key moves the cursor to the beginning of the row if it’s not already there. If the cursor is at the beginning of the row and you 
press the <Home> key, it will move to the beginning of the layer.   If the cursor is already at the first character of the layer, the <Home> 
key will move the cursor to the beginning of the “Main” layer.  The <End> key moves the cursor to the end of the row if it’s not already 
there. If the cursor is already at the end of the row, it will move to the end of the layer.  If the cursor is already at the end of the layer, the 
<End> key will move the cursor to the end of the “Main” layer. 
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Editing Text 
Move the mouse over the “R” in “Really” and press down the left button on the mouse. While holding down the Left button, drag the 
mouse to the “i” in “Like” and release the mouse button. Notice how the cursor expands to cover the text “Really Li”.  This is the text that 
is now selected. Any operations done to the text will be done to the text that is selected. Press the <Del> key. The text that was selected 
was deleted.  To get this text back, hold down the <Ctrl> key and press the <Z> key (you could also press the UNDO button in the 
toolbar).  The last operation (delete in this case) is undone. The Title Composer will let you UNDO as many as 1000 operations. 
 
Move the cursor to the “C” in the word “Composer”. Hold down the <Shift> key and press the <Enter> key. This splits the row into two 
rows. A new row is created under the current row and the character that the cursor is on, and all characters after it, are moved down to the 
new row. 
 
Press the <Enter> key to move the cursor to the beginning of the next row. Hold down the <Shift> key and press the <Ins> key. This 
inserts a new row at the cursor position. Now type “Datavideo”.  Let’s delete this new row. We could use the UNDO function, but let’s 
use the delete row function instead.  Hold down the <Shift> key and press the <Del> key. The cursor row is deleted and all rows 
underneath it move up to take its place. 
 
Move the cursor to the “R” in “Really”. Delete this word by holding down the <Ctrl> key while pressing <Del>.   The entire word is 
deleted and all text to the right of it moves over to fill in the space. Move the cursor to the “i” in “like”. Type the letters “ove”. The new 
letters replace (overwrites) the text already on the screen.  The typing mode can be changed to “Insert” (see the “Insert Mode” command in 
the “Settings” menu).  
 
Move the cursor to the beginning of the second word on the top row. Insert five (5) spaces by holding down the <Alt> and pressing the 
<Ins> key 5 times. Now type the characters “Just”. This enters a new word in the space that you just inserted (4 characters for the word, 1 
character for the space).  
 
The functions that you just learned (as well as others) can also be invoked by using the commands in the “Edit” menu. This menu also 
shows the keyboard short cut keys for these commands in case you forget them. 
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Saving the Page 
Before we go through the “Erase Text” functions, let’s save the page so we can use it later.  Select the “Save Page” command from the 
“File” menu, or press the Third button (with the floppy disk icon) in the Toolbar.  Since this page has not yet been named, you will be 
prompted to enter a name for it.  Once the name has been entered (Let’s call it FIRST) press the “Save” button and the page will be saved 
to the current project.  Notice that a small “PICON” of the page appears in the Project Manager window along with the name of the page. 
 
Erasing Text 
The “Edit” menu has commands for erasing text. You can erase text from the cursor position to the end of the row, from the cursor 
position to the end of the page, or all of the text on the page. 
 
Move the cursor to the “V” on the first row, then go to the “Erase Text” entry in the “Edit” menu and select “to End of Row” command.  
Notice that all of the text from the cursor position to the end of the row is erased. 
 
Select the “to End of Page” command and all of the text from the cursor position to the end of the page is erased. Select the “Entire Page” 
command, and all of the text on the page is erased. 
 
Backspace 
If you make a mistake while typing (such as typing the wrong character) just press the <Backspace> key.  This will move the cursor to the 
previous position and erase the character there.  If the system is in Insert mode, the character will be deleted.  You can then type the correct 
character. 
 
Using Tabs 
The Title Composer allows you to set up to 16 tabs per page.  These tabs specify horizontal positions on the screen. Columnar text can be 
aligned to the tabs.  If the Tab Display is enabled, the tab positions appear as vertical lines the entire height of the screen.   
 
The tabs behave differently depending on the typing mode.  In the Insert mode, pressing the <Tab> key will insert a tab character at the 
cursor position.  All text to the right of the new tab will be moved to the next tab position.  Pressing the <Tab> key in the Overwrite 
typing mode will move the cursor to the character at the next tab position.  If no tab is set to the right of the cursor, the cursor will move to 
the beginning of the next row. 
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The width of the Tab character is automatically adjusted so that the next character is placed at the next tab position.  If no tab is set to the 
right of the tab character, it is treated the same as a space.  Changing the text to the left of the tab character (by entering more text or 
changing the size of the text) will not move the text that you have placed at the next tab position unless the text becomes too big to fit in 
the allotted space. 
 
Normal typing will not overwrite a Tab character (even in the Overwrite typing mode).  Any text that is entered before the tab will be 
inserted at the cursor position and the width of the tab will be adjusted to keep the text at the next tab position from moving.  To get rid of 
a Tab character, use the <Backspace> or <Del> key. 
 
The tab positions are stored with the page.  When a page is recalled from the disk, the tab positions that the page was created with are 
loaded with it. 
 
For more information on default set tabs, setting tabs, deleting tabs, and tab display see the section titled “Setting Up Tabs” in chapter 14. 
 
Row Space Allocation 
As text is entered, sized, and repositioned, rows of text may begin to overlap each other, or may appear with too much spacing between 
them.  To set the Row spacing back to what it should be (based on the text on the row), press the “Reset Row Spacing” button in the 
shortcuts window to reset the height of every row of the page. 
 
Cursor Movements 
The cursor movement keys allow you to move the cursor around the screen. The cursor can also be positioned with the mouse. 
 
Cursor Up 
The <↑> key moves the cursor up one row unless it is already on the top row of the page.  If the cursor is on the top row of the screen and 
you are editing a Credit Roll page, the text will scroll down.  This allows you to re-edit the text that has been scrolled off the screen. 
 
Cursor Down 
The <↓> key moves the cursor down one row.  If this moves the cursor below the bottom margin, and you are editing a Credit Roll page, 
the page will scroll up to keep the cursor within the margins, 
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Cursor Left 
The <←> key moves the cursor left one character position.  If the cursor is at the left margin, the cursor will move to the end of the next 
row up (provided it’s not already on the top row).  If the page is a Crawl, the text will scroll right to let you re-edit the text that has already 
crawled off the left side of the screen. 
 
Cursor Right 
The <→> key moves the cursor right one character position.  If this moves the cursor beyond the end of the row, the cursor will move to 
the beginning of the next row unless the page is a Crawl page.  In this case the text will scroll to the left to keep the cursor within the 
margins. 
 
Home 
Press the <Home> key to move the cursor to the first character of the row.  If the cursor is already on the first character of the row, 
pressing the <Home> key will move the cursor to the first character position of the first row of the layer.  If the page is a Credit Roll, it will 
scroll down until the very first row of the page is shown.  If the page is a Crawl, the page will scroll right to show the first character. 
 
End 
Press the <End> key to move the cursor to the last character of the row.  If the cursor is already on the last character of the row, Pressing 
the <End> key will move the cursor to the last character of the layer.  If the page is a Credit Roll or a Crawl page, it will scroll until the last 
character appears. 
 
Page Up 
Pressing the <Page Up> key will move the cursor to the last character on the screen unless the page is either a Credit Roll or a Crawl.  If it 
is a Credit Roll, it will scroll up the height of the screen.  If the page is a Crawl, the text will scroll left the width of the screen. 
 
Page Down 
Pressing the <Page Down> key will move the cursor to the home position screen unless the page is either a Credit Roll or a Crawl.  If the 
page is a Credit Roll, the page will scroll down the height of the screen (if there is text above the screen).  If the page is a Crawl, it will scroll 
right the width of the screen (if there is text to the left of the screen). 
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Setting Cursor Position with the Mouse 
The cursor can be moved with the mouse.  Move the mouse pointer to the desired position and click the left button.  The cursor will move 
to the character being pointed to.  If characters are overlapped, continue to click the left button until the desired character is selected 
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Text Styles 
 
One of the most amazing things about Title Composer is the amount of control you have over the text style.  Each character is made up of 
six different components.  These are the character, two edges, and three shadows. 
 
Each of these six character components can be set to either a solid color, a vertical color spread from the top to the bottom of the 
character, a color gradient that you can define, or a texture. 
 
You can select a TrueType Typeface for the character and control the Height, Width, Italics Angle, Rotation, Kerning, and the Blur of the 
character. 
 
For each edge you can select the Edge Type, Direction, Depth, and the Blur.  For any of the three shadows you can select the shape (to be 
the same as the Character, Edge 1, or Edge 2) and the offset from the character.  The shadow can be offset from a character by as much as 
100 pixels horizontally and vertically. 
 
Many of the text style attributes (height and width for example) are represented numerically.  These numerical attributes can be modified by 
controls that are either absolute or relative.  An absolute control will set all of the selected text to the new value.  A relative control will 
change all of the selected text by the same amount. 
 
To illustrate the difference between absolute and relative, let's assume there is a word on the screen.  The size of the first character of the 
word is 50 scan lines; the rest of the word is 25 scan lines high.  If you select the entire word and use a relative control to increase the height 
of the first character by 25 scan lines from (50 to 75 scan lines), the height of the rest of the word will be increased by 25 scan lines to 50 
scan lines. 
 
If you use an absolute control to set the height of the first character to 60 scan lines, the height of the entire word will be set to 60 scan 
lines (they won't maintain their height relative to each other). 
 

Chapter 

3



C H A P T E R  3  -  T E X T  S T Y L E S  

 26

Character Styles 
To change the character style, select the Character Tab in the Control Tab Window.  The controls for adjusting the character style will be 
displayed as shown below. 
 

 
 
This control tab window has 6 groups of controls to control numerical character attributes.  It also has a Cursor Handle Button, a Typeface 
selection box, and a button that you can press when you want to load new Typefaces. 
 
The numerical control groups are: 
 
Height 
Width 
Italics 
Rotation 
Kerning 
Blur 
 
Each group of numerical controls is made up of 4 controls.  The top control in the group (the one with the icon) is a drag button.  The drag 
button is the relative control of the group.  To use the drag button, move the mouse over it, press the left mouse button, and drag the 
mouse.  Moving the mouse up or to the right will increase the value.  Moving the mouse down or to the left will decrease the value.  The 
other three controls in the group are the absolute controls. 
 
The absolute controls consist of a number box and two small buttons to the right of it for increasing and decreasing the value.  The value in 
the number box can be entered directly by moving the mouse over the number, double clicking the mouse (this will highlight all of the 
digits in the number), and entering the new value.  Pressing the increase button to the right of the value can increase the value.  If you hold 
this button down the value will continue to increase until you release the button.  To decrease the value, press the decrease button.  Holding 
down this button will continue to decrease the value until you release it. 
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If you move the mouse over the number, then press and hold down the left mouse button, you can change the value by moving the mouse.  
Moving the mouse up or to the right will increase value.  Moving the mouse down or to the left will decrease the value.  When you have the 
desired value, release the left mouse button. 
 
The Cursor Handle Button performs two functions.  It allows you to turn the cursor handles on and off.  It’s also there as a reminder as to 
what each cursor handle is used for. 
 
The Typeface selection box lets you select a different Typeface and there is an "Add New Typefaces" button that you can press when none 
of the 25 typefaces that are currently loaded are what you want. 
 
Let's explore these buttons a little closer.  Create a new page by pressing the New Page icon in the toolbar and select a Still page type.  
From the style gallery select a reasonably sized text style.  Then type the word TEST in all capital letters.  Press the home key to move the 
cursor to the first “T” in the word “TEST”. 
 
Move the cursor over to the Height Drag Button, press and hold down the left mouse button and move the mouse up.  Notice that the size 
of the character increases.  Release the left mouse button. 
 
Drag the cursor across the entire word to select it.  Move the mouse over the Height Drag Button, press and hold down the left mouse 
button, and move the mouse down.  Notice that the height of every character in the word decreases by the same amount.  The value of the 
number box is changed to display the current height of the first character that is selected.   
 
Now let's see how the absolute controls behave differently.  Move the mouse to the height number box and double-click it.  This will 
highlight all of the digits.  Re-enter the digits exactly as they were before (if they were originally 48, enter 48) and press the <Enter> key.  
Notice that all of the characters became the same size as the first character; they did not maintain their relative character heights. 
 
The height of the characters can be varied and set to any size between 600 scan lines high and negative 600 scan lines high.  The negative 
character height will draw the characters inverted (upside down).  Try experimenting with the height controls to see how they affect the 
characters. 
 
Changing the width of the characters will make them appear thinner or wider.  The width can be varied anywhere between 10 percent of 
normal (very thin) to 500 percent of normal (five times their normal width).  A width of 100% is the normal width for the character.  Try 
experimenting with the width controls to see how they affect the characters. 
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The italics angle of the text can be varied up to 45 degrees in either direction.  A negative italics angle will slant the characters to left, the 
positive italics angle will slant the characters to the right.  Try experimenting with the italics controls to see how they affect the characters. 
 
Each individual character, or group of characters, can be rotated up to 360 degrees in either direction.  A positive value will rotate the text 
clockwise, while a negative value will rotate the text counter clockwise. 
 
The kerning controls allow you to change the spacing between the characters.  A negative value will move the characters closer together.  A 
positive value will move the characters further apart. 
 
The amount of blur on the characters can be changed using the blur controls.  A blur value of 2 gives you a crisp sharp character; a blur 
value of 12 gives you a very fuzzy character.  The blur of the character and the blur on each of the two edges can be set independently of 
each other.   
 
Cursor Handles 
Cursor Handles are points on the cursor that allow you to click and drag the text around the screen.  With these handles you can move, size, 
rotate, and italicize the text.  The Cursor Handle Button (on the right hand side of the character tab window) is used to turn the Cursor 
Handles on and off.  It also has a little diagram that shows what each handle is used for.   
 
Turn the cursor handles on by pressing the Cursor Handle Button.  Notice that eight small boxes appear around cursor.  Each of these 
small boxes is a handle.  You can move the selected text by clicking on the handle in the lower left corner and dragging the mouse.  Each 
time you pause the mouse, the text will be redrawn at the new position.  If you only want to move the text horizontally (without affecting 
the baseline alignment) you can use the handle on the left side of the cursor.  If you accidentally move the mouse vertically while dragging 
this handle, the text will not move vertically.  Using the handle on the bottom of the cursor will only move the text vertically; it will not 
allow it to move horizontally. 
 
Use the handle at the top of the cursor to adjust the height of the characters.  When you change the size of the cursor by dragging this 
handle, the height of the text will be changed to match the cursor size.  The relative size of each selected character will be maintained. 
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Use the handle on the right side of the cursor to adjust the width of the text.  Dragging this handle left or right will change the relative 
width of each selected characters.  When you change the width of the cursor by dragging this handle, the relative width will be adjusted to 
fit within the new cursor size. 
 
Dragging the handle on the upper right corner of the cursor will adjust both the height and width of the text.  Dragging the handle on the 
lower right corner of the cursor will rotate the selected text.  Dragging the handle on the upper left corner of the cursor will change the 
italics angle of the text. 
 
When you are through using the cursor handles, and you no longer want them to be displayed, press the Cursor Handle Button again to 
turn the handles off. 
 
Typefaces 
The typeface selection box shows the current typeface.  If you open this box up by pressing the down arrow on the right hand side, all of 
the typefaces that are currently loaded will appear.  Click on any typeface in this list to select it.  When a new typeface is selected, the 
selected text will be redrawn with the new typeface. 
 

L O A D I N G  N E W  T Y P E F A C E S  

Title Composer can load two types of typefaces, Datavideo format or TrueType format.  The Datavideo format is a proprietary format.  
The typefaces that came with the program are in this format.  The TrueType format is the most popular format and has the widest 
selection of typefaces.  You can load up to 25 typefaces for each project.  When you use typefaces on a page, the system keeps track of 
which typefaces are needed to display the page.  If the loaded typefaces do not match the typefaces needed by the page, the correct 
typefaces are automatically loaded. 
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To load new typefaces press the "Add New Typefaces" button.  When this is done the Load New Typefaces window will appear as shown 
below. 
 

 
Load New Typefaces dialog box 

 
The typefaces that are currently loaded are listed on the right hand side of this window.  The typefaces that are available to be loaded (in the 
current directory) are listed on the left hand side.  The current directory is displayed in the center. 
 
Select the typeface format (TrueType or Datavideo) that you want to load.  All of the typefaces in the current directory of the selected 
format will appear on the left side under “Available Typefaces”.  If the typefaces are TrueType, the full name of the typeface is shown in 
the actual typeface (for example, the name Helvetica will appear in the Helvetica typeface, the name Times New Roman will appear in 
the Times New Roman typeface).  You can use this feature to preview the typefaces without the need to load them first.  To get a better 
look at a typeface, click on it in this list.  A larger sample of this typeface will appear. 
 
If the desired typeface is not in the current directory, select the proper directory.  Your system typefaces are usually stored in the 
"C:\WINNT\FONTS" or the "C:\WINDOWS\FONTS" directory\folder. 
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The typefaces do not need to be installed on your system.  You can load typefaces directly from a CD-Rom.  When you load a TrueType 
typeface, a copy of it is made on your hard drive (in the CG-300\TYPEFACE folder).  You can then remove the CD-Rom and the 
program will still be able to find the typefaces when it needs them. 
 
To load a new typeface, select the position that you want to load it into in the “Loaded Typefaces” list, select the typeface to load in that 
position from the “Available Typefaces” list, then press the load button.  The new typeface will appear in the “Loaded Typefaces” list and 
the next position in the “Loaded Typefaces” list will be selected.  The typeface may also be loaded by double-clicking on it in the “Available 
Typefaces” list.   
 
When you have finished loading typefaces press the “Done” button and the Load New Typefaces window will disappear.  Notice that the 
new typefaces now appear in the Typeface Selection Box. 
 
Scope Selection  
Now that we have the basics of character attributes down, let's try something a little more advanced.  Create a new page, and set the Page 
Type to the Still.  Set the character Height to 24 scan lines, the Width to 100 percent, Italics to 0 degrees, and Rotation to 0 degrees.  Set 
the Kerning to 0 and the Character Blur to 2.  Selected a clean/easy to read typeface such as Boston Black, Futurist, or Bassett Bold.  Now 
type the following three lines of text: 
 
The quick Brown Fox 
jumped over the 
lazy dogs back. 
 
Place the cursor on the M in the word “jumped” and select a different typeface.  Notice that only the character under the cursor changed.  
If the toolbar is visible (above the title compose window) you'll see a selection box with the words "Selected Text".  This is called the 
“Scope Selection Box.” This selection box is used to determine how much text the Text Style changes will affect.  If the toolbar is not 
visible, display it by selecting the “Display Toolbar” command from the “View” menu.  Open this box by pressing the down arrow and 
the following options will appear: 
 
Selected Text 
to End of Word 
Entire Word 
to End of Row 
Entire Row 
to End of Layer 
Entire Layer 
Entire Page 
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Change this selection to “to End of Word”, then change the rotation angle to minus 10 degrees.  Notice that every character from the M to 
the end of the word is rotated.  Go back to the toolbar and change the selection to “Entire Word”.  Increase the height to 48 scan lines.  
Notice that the height of the entire word changed.  Now select the “to End of Row” entry from the scope selection box and set the width 
to 50 percent.  Notice that all text from the cursor position (the M in jump) to the end of the row changed its width. 
 
Set scope to “Entire Row” and select a new typeface.  Every character on the row is now drawn with the new typeface.  Select “to End of 
Layer” from the scope selection box and set the height to 60 scan lines.  Every character from the cursor position to the end of the row, 
and every character on every row after the cursor changed to the new height.  Now select “Entire Layer” as the scope and select a new 
typeface.  Notice that every character on the page changed to the new typeface.  There is one more entry in the scope selection box that we 
have not discussed yet.  It is “Entire Page”.  Selecting this entry would change all of the text on all of the layers if we had multiple layers on 
the page.  You'll find out more about this when we discuss Layers in Chapter 4. 
 
When “Selected Text” is chosen, the changes are applied to the character or group of characters that are selected by the cursor.  To select 
multiple characters, move the mouse to the first character to select, hold down the left mouse button, and drag the mouse to the last 
character to select.  Dragging the mouse will not select text that is on more than one row unless the <Shift> key is held down while the 
mouse is being dragged. 
 
Row Spacing (Leading) 
When we increased the size of the text, the rows of text overlapped each other.  Sometimes we want this effect, other times we don't.  If 
you want to adjust the row spacing to match the text, press the “Reset Row Spacing” button in the “Shortcut buttons” window (to the 
right of the title compose window).  This will adjust the row spacing (leading) so that the rows don't overlap. 
 
With “Entire Layer” still selected as the scope, set the Height to 24 scan lines and the Rotation angle to 0 degrees.  Now there is too much 
space between the rows.  Press the “Reset Row Spacing” button again and the excess row spacing (leading) will be removed. 
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Edges 
To change the Edge Styles, select the Edges Tab in the Control Tab Window.  The controls for changing the edges will be displayed as 
shown below. 
 

 
This control tab window has 2 complete sets of controls for controlling both edges.  The controls on the left are used to set Edge 1; the 
controls on the right are used to set Edge 2.  Since both sets of controls are identical, we will discuss both of them at the same time. 
 
Each set of edge controls are made up of four groups of controls.  One group selects the Edge Type, another group selects the Direction of 
the edge, and there are two groups used to control the numerical values Edge Depth and Edge Blur. 
 
Edge Type 
The Edge Type is controlled by a group of five buttons.  These buttons are called radio buttons because only one button can be selected at 
the time (just like buttons on the car radio).  Pressing one button will deselect the others.  These buttons are used to select the edge type 
and to indicate the current edge type.  The edge types that can be selected are as follows: 
 

N O  E D G E  

 

Shows just the characters without any edge. 

 
F U L L  S U R R O U N D  B O R D E R   

 

Displays the characters with a border around them.  The border has equal depth on all sides of the character.  The depth of the 
border is set by the Depth controls. 

 
E X T R U D E D  S H A D O W  

 

 

Extruded Shadows appear connected to the character.  This gives the characters sort of a three-dimensional look.  The direction 
of the shadow is determined by the Direction controls, and the depth is set by the Depth controls.  
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H I G H L I G H T E D  S H A D O W  

 

 

A Highlighted Shadow is very similar to an extruded shadow.  However a fine border appears to highlight the character.  The 
direction of the shadow is determined by the Direction controls, and the depth of the shadow is set by the Depth controls. 

 
O F F S E T  S H A D O W  

 

 

An Offset Shadow is separated from the character.  This makes it appear as though the character is above the background and is 
casting a shadow on it.  The direction of the shadow is determined by the Direction controls, any offset of the shadow is set by 
the Depth controls. 

 
Pressing the appropriate button selects the edge type. The button then appears depressed to indicate the current edge type. 
 
Edge Direction 
The direction of the extruded shadow, highlight shadow, and offset shadows can be controlled.  The direction control group (shown below) 
controls the direction. 
 

 
 
There are eight buttons around the outside of this group.  Each button represents one of the eight possible directions (Upper Left, Up, 
Upper Right, Right, Lower Right, Down, Lower Left, and Left).  Pressing one of these buttons will select the corresponding Shadow 
Direction.  When the direction is selected, the button appears depressed to indicate the current direction. 
 
There is also a button/indicator in the middle of the Direction Selection Buttons.  This also indicates the current shadow direction.  
Pressing this button will advance the shadow direction clockwise to the next direction. 
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Edge Depth 
The depth of the edge is a numerical parameter that can be varied from 0 to 99 pixels.  An edge depth of zero will not be seen unless you 
make the edge blurrier than the character.  Setting the edge depth to 99 scan lines will make an extremely deep edge that may slow down the 
drawing of the characters.  If you want a really deep edge like this, and you have a slower CPU, I suggest that you compose the page using a 
smaller edge first.  This lets you compose the page without being slowed down too much.  After the text is typed, you can make the edges 
as deep as you want.  The edge depth will not have any effect on the edge if the Edge Type is No Edge. 
 
The numerical controls in this group have both Relative and Absolute controls.  They work just like the numerical controls on the 
Character Tab. 
 
Edge Blur 
The amount of blur on the edges can be changed by the controls in this numerical control group.  A Blur setting of 2 gives a crisp sharp 
edge; a blur setting of 12 gives you a fuzzy edge.  The Blur of each edge and the character can be set independently of each other. 
 
Shadows 
The Title Composer can display each character with 3 independent shadows.  These are called Shadow 1, Shadow 2, and Shadow 3.  
Shadow 1 is drawn behind the character and in front of Edge 1.  Shadow 2 is drawn between Edge 1 and Edge 2.  Shadow 3 is drawn 
behind Edge 2.  You can control the shape and offset (horizontal and vertical) of each shadow independently.   
 
To change the Shadow Styles, select the Shadows Tab in the Control Tab Window.  The controls for changing the shadows will be 
displayed as shown below. 
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This control tab window has 3 complete sets of controls for controlling all three shadows.  The controls on the left are used for Shadow 1, 
the controls in the middle are used for Shadow 2, and the controls on the right are used for Shadow 3.  Since all three sets of controls are 
identical, we will discuss all three of them at the same time. 
 
Each set of shadow controls are made up of 2 groups of controls.  One group selects the Shape of the shadow; the other group selects the 
shadows’ offset. 
 
To help demonstrate the Shadows, we should make both of the edges look significantly different from the character as well as each other.  
Select the “Character” Tab.  Set the Height to 48 scan lines, the Width to 100%, the Italics and Rotation angles to 0 degrees, and the Blur 
setting to 2.  Now select the “Edges” Tab.  Set the Edge 1 type to “Full Surround”, set its’ Depth to 8 pixels, and set its Blur to 7.  Set the 
Edge 2 type to “Extruded Shadow”, set it’s direction to “Lower Right” set its’ Depth to 30 pixels, and its’ Blur to 12. 
 
We also need to set the character, edge, and shadow colors so we can easily tell them apart.  Warning - this could end up looking ugly.  
Select the “Colors” Tab; this will display the color controls.  Press the “Palette” button to display the preset color palette. 
 
Press the “Character” button in the “Component” control group to tell the system that we want to change the Character color (make sure 
both the “Top Color” and “Bottom Color” check boxes are marked).  Scroll down in the color palette until the “White” entry appears and 
select it as the character color.  Press the “Edge 1” button, make sure both the “Top Color” and “Bottom Color” check boxes are marked, 
and select a “Reddish” color for it from the color palette.  Press the “Edge 2” button, make sure both the “Top Color” and “Bottom 
Color” check boxes are marked and select a “Greenish” color for it from the color palette. 
 
Let’s set the Shadow colors now.  Press the “Shadow 1” button; make sure that both the “Top Color” and “Bottom Color” check boxes are 
marked, and select a “Blue” color for it.  Press the “Shadow 2” button; make sure that both the “Top Color” and “Bottom Color” check 
boxes are marked, and select a “Magenta” color for it.  Press the “Shadow 3” button, make sure that both the “Top Color” and “Bottom 
Color” check boxes are marked, and select a “Yellow” color for it.  Now we can definitely tell which component (Character, Edge, and 
Shadow) is which. 
 
Select the “Shadows” tab to display the “Shadows Control Window”.  Type the word “SHADOWS” on the screen then drag the mouse 
over the word to select the entire word. 
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Select “None” as the shape of all three shadows.  Use the “Offset” controls for each shadows to set the offsets of each shadow to the 
following: 
 
 Vertical Offset Horizontal Offset 
Shadow 1    8    9 
Shadow 2 -26 -27 
Shadow 3 -40  30 
 
Shadow Shape 
The Shadow Shape control group is made up of 4 buttons (to select the shape of the shadow)  and an indicator (to indicate the current 
shadow shape). 
 
A shadow can be set to be the same shape as the Character, Edge 1, Edge 2, or it can be turned off.  To turn the shadow off, press the 
“None” button.  To make the shadow the same shape as the character, press the “Character” button.  To make the shadow the same shape 
as edge 1, press the “Edge 1” button.  And so on. 
 
As each shape is selected, the Current Shadow Shape Indicator (below the shape selection buttons) will change to indicate the current 
shadow shape.  You can also click on the Current Shadow Shape Indicator to advance the shape of the shadow to the next shape. 
 
Select the different shapes for Shadow 1.  Notice that when you select the shape for the shadow, it appears as blue (earlier, we selected blue 
as the shadow one color) behind the Character and in front of Edge 1 (the red edge).  Do the same for Shadow 2 and Shadow 3.  Notice 
that Shadow 2 (magenta) is drawn behind Edge 1 (the red edge) and in front of Edge 2 (the green edge).  Shadow 3 (yellow) is drawn 
behind Edge 2. 
 
Set the shape of Shadow 1 to “Character”, the shape of Shadow 2 to “Edge 1”, and the shape of Shadow 3 to “Edge 2”. 
 
Shadow Offset 
The shadows can be offset from the character in any direction in single pixel increments.  The shadows can be offset horizontally from the 
character by as much as 100 pixels in either direction.  A negative value offsets the shadow to the left.  A positive value offsets the shadow 
to the right.  The shadows can be offset vertically from the character by as much as 100 scan lines.  A positive value places the shadow 
above the character; a negative value places the shadow below the character 
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The shadow offset controls for each shadow work very similar to the numerical controls in the “Character” and “Edges” tabs.  The offset 
drag button (shown below) can be used to control both the vertical and horizontal offsets. 
 

 
 
Dragging the mouse left or right will adjust the horizontal offset.  Dragging the mouse up or down will adjust the vertical offset. 
 
Click on the "H" in shadows to select it.  Click on the Shadow 1 Vertical Offset Number Box and drag the mouse down.  The blue shadow 
(Shadow 1) moves down when you move the mouse.  Click on the Shadow 1 Horizontal Offset Number Box and drag the mouse to the 
right.  Shadow one moves to the right when you move the mouse. 
 
Notice that Shadow 1 on the “H” character is in a different position than Shadow 1 on the other characters.  Drag the mouse across the 
entire word to select all the characters.  Position the mouse over the Shadow 1 Offset Drag Button and press the left mouse button.  Now 
move the mouse around while holding down left button.  Notice that shadow 1 on all of the characters moves with the mouse, and that 
Shadow 1 on the “H” maintains its position relative to the rest of the characters. 
 
Try experimenting with the offsets for Shadow 2, and Shadow 3.  You'll see that they work exactly the same way as Shadow 1. 
 
Save this page with the name “SHADOWS”. 
 
Text Colors 
Select the “Colors” Tab in the Control Tab Window to adjust the Text Colors.  This will display the Colors Control Window (shown 
below). 
 

 
 



C H A P T E R  3  -  T E X T  S T Y L E S  

 
 

39

The Colors Control Window has three main sections.  The first section (on the left) is used to select which component of the text 
(character, shadow 1,edge 1,shadow 2, edge 2, or shadow 3) to change the color of.  The next section is a group of buttons used to select 
the method of choosing a color (color picker, color sliders, color palette, color gradient, or textures).  The last section has the controls used 
in choosing a color.  These controls change based on the method of choosing a color that you have selected.   
 
Text Components 
The component group of controls contains six buttons for selecting which component of the text to change the color of, (character, edges, 
or shadows).  To change the character color, press the “Character” button.  To change the color of edge 1, press the “Edge 1” button.  And 
so on.  When a new text component is selected, the color indicator box in the lower left corner of this group is changed to display the 
current color.  The color indicator box displays the current color as it is being modified. 
 
The component section of the Colors Control Window has an indicator to show the current color of each text component.  These boxes 
display the text components in the same order that they will appear on the screen.  The front box of this indicator shows the current 
Character color.  The box behind it (that is offset down and to the right of it) shows the current Shadow 1 color.  The box that is behind to 
both the Character and Shadow 1 indicators, displays the current Edge 1 color.  The box behind and offset down to the right of the Edge 1 
indicator, displays the current Shadow 2 color.  The box that is behind both the Edge 1 and Shadow 2 indicators, displays the current Edge 
2 color.  The box behind all of the others is the Shadow 3 color indicator. 
 
If you click on any of these indicators, the component that it represents will be selected.  The appropriate component selection button will 
appear depressed to indicate the current component.  The color indicator box will also be changed to the color of the selected component. 
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Color selection methods 
There are five different methods of selecting a color.  These methods are as follows: 
 

The Color Picker lets you select the color using a visual approach 
 
The Color Sliders lets you select the color using a numerical approach. 
 
The Color Palette lets you select a color from a palette of 64 preset colors. 
 
A color can be selected from a group of 64 user defined color gradients.  This may be either a linear gradient with up to 
16 color points that can be rotated up to 90 degrees in either direction.  It can also be an area gradient that can have four 
or five color points defined. 

 
A Color Texture can be selected from any of the 16 textures that are currently loaded. 
 
Before we begin experimenting with changing colors of the text, we should have some text that uses both of the edges 

and all three of the shadows.  Let's open the “Shadows” page (if it isn't already open) that we created earlier.  Drag mouse across the entire 
word to select all of the characters.  We are now ready to play with the colors. 
 

C O L O R  P I C K E R  

Press the “Picker” button to display the color picker controls.  The color picker controls are shown below. 
 

 
 
The top and bottom of each character component can each be set to different colors.  There are two boxes to select whether we want to 
change the top color, the bottom color, or both.  If the top and bottom colors are different, the text will be drawn with a smooth color 
spread between the two colors. 
 

Color Picker 

Color Sliders 

Color Palette 

Color Gradient 

Color Texture 
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Below these check boxes is an Illegal Color Indicator.  If the selected color exceeds NTSC or PAL limitations, this box will appear red to 
indicate that you have selected an illegal color.  Otherwise this box will appear green. 
 
Below the illegal color indicator is the “Pick Color From Screen” button.  Pressing this button will change the appearance of the mouse to 
look like an eyedropper.  Move the mouse to any position on-screen that you want to copy the color of, press the left mouse button and the 
color under the mouse will be selected. 
 
To the right of these controls is the Hue Picker.  This lets you select the hue (red, green, blue, etc.) of the color.  Place the mouse over this 
control, and press the left mouse button to select the desired hue.  When the new hue is selected, the text will be redrawn with the new 
color, and the Color Picker Area (to the right of the Hue Picker) will also be drawn with the new hue. 
 
Once the Hue is selected you can now pick the color.  Place the mouse over the Color Picker Area and press the left mouse button.  This 
will select the color under the mouse.  If you hold down the left mouse button while you move the mouse, the text will be redrawn with 
new color each time you select a new color by moving the mouse. 
 
You can also control the Transparency of the color.  The transparency setting can make the color fully opaque, semi-transparent, or fully 
transparent.  When a color is semi-transparent, the text component is drawn as tinted over whatever is behind it.  When the color is fully 
transparent, it can’t even be seen on the screen.  Setting the transparency level to 0 makes the object fully opaque.  Setting the level to full 
(255) makes the object fully transparent.  Any value in between makes a color that is semi-transparent. 
 
There are a variety of ways to change the Transparency level.  Pressing the increase button to the right of the transparency number box will 
increase the level.  If you hold this button down the level will continue to increase until you release the button.  To decrease this value, press 
the decrease button.  Holding down this button will continue to decrease the value until it is released.  If you move the mouse over the 
transparency number box, then press and hold down the left mouse button, you can change the value by moving the mouse.  Moving the 
mouse up or to the right will increase the value.  Moving the mouse down or to the left will decrease the value.  When you have selected the 
desired value, release the left mouse button. 
 
The value of the transparency level can be entered directly.  Do this by double-clicking the transparency number box (this will highlight all 
of the digits in the number), type in the new value and press the enter key. 
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The color can be also mixed with background video.  Setting the video level to a value of zero makes the object the selected color.  Setting 
the video level to full (255) draws the object with background video.  Any value in between makes the object appear as background video 
that is tinted by the selected color.  For some very interesting effects, try blending colors, background video, and transparency over a 
background graphic image. 
 
The background video level can be adjusted in the same way as the transparency level. 
 

C O L O R  S L I D E R S  

Press the “Sliders” button to display the Color Slider controls.  The Color Slider controls are shown below. 
 

 
 
The top and bottom of each character component can be set to different colors.  There are two check boxes to select whether we want to 
change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top and bottom colors are different, the text will be 
drawn with a smooth Color Spread between the two colors. 
 
Below these check boxes is the Illegal Color Indicator.  If the selected color exceeds the NTSC or PAL limitations, this box will appear red 
to indicate that you have selected an illegal color.  Otherwise this box will appear green. 
 
The Title Composer has two (2) numerical systems for defining colors.  They are RGB (Red, Green, Blue) and HLS (Hue, Luminance, 
Saturation).  Both of these systems are used to define the same thing (like yards and meters).  Adjusting one will automatically change the 
other.  You can select which method to use by pressing either the RGB or HLS button.  You can switch back and forth between the 2 color 
systems at any time just by pressing the appropriate button. 
 
The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking the number box and entering the new value with 
the keyboard. 
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C O L O R  P A L E T T E  

Press the “Palette” button to display the preset color palette.  The Color Palette is shown below. 
 

 
 
The preset Color Palette can hold 64 preset colors.  These preset colors are displayed in this window.  Not all of the preset colors can be 
displayed at one time, so there is a scroll bar on the right hand side of the color palette entries.  Use this scroll bar to scroll through all of 
the preset colors. 
 
The top and bottom of each character component can be set to different colors.  There are two check boxes to select whether we want to 
change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top and bottom colors are different, the text will be 
drawn with a smooth Color Spread between the two colors.   
 
Below these two check boxes is the Illegal Color indicator.  If the selected color exceeds the NTSC or PAL limitations, this box will appear 
red to indicate that you have selected an illegal color.  Otherwise this box will appear green.   
 
To select a color from the preset color palette, position the mouse over the desired color and click the left mouse button.  You can change a 
color in the preset Color Palette by double clicking the entry that you want to change.  For more information about modifying the preset 
Color Palette, see the section "Modifying the Color Palette" in chapter 14. 
 
This window also has a button labeled "Background Video".  Pressing this button will set the color so that the text will be drawn with 
background video. 
 



C H A P T E R  3  -  T E X T  S T Y L E S  

 44

C O L O R  G R A D I E N T S  

Press the "Gradient" button to display the color gradients.  The Color Gradients selection window is shown below. 
 

 
 
64 color gradients can be loaded into the system at one time.  The Color Gradients that are currently set are displayed in this window.  Not 
all of the color gradients can be displayed at one time, so there is a scroll bar on the right hand side of the Color Gradient entries.  Use this 
scroll bar to scroll through all of the color gradients that are currently set for the project. 
 
To select a color gradient, position the mouse over the desired gradient and click the left mouse button.  The text will then be drawn with 
the selected color gradient.  You can edit a Color Gradient, or build a new one, with the gradient builder.  To do this, double-click the Color 
Gradient that you want to modify.  For more information about using the gradient builder, see the section "Building Color Gradients" in 
chapter 14. 
 

C O L O R  T E X T U R E S  

Press the "Textures" button to display the Color Textures selection window.  The Color Textures selection window is shown below. 
 

 
 
16 full Color Textures can be loaded into the system at one time.  The Color Textures that are currently loaded are displayed in this 
window.  The Textures are displayed large enough so that you can easily see what the texture looks like.  Not all 16 textures can be 
displayed in this window at one time, so there is a scroll bar on the right hand side of the textures.  Use this scroll bar to scroll through all 
of the textures that are currently loaded. 
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To select a Color Texture, position the mouse over the desired texture and click the left mouse button.  The text will then be drawn with 
the selected texture.  You can load a new texture by a double-clicking on the one that you want to replace.  When this is done you will be 
asked to specify which graphic image you want to load as a texture.  For more information about loading graphic images as Color Textures, 
see the section "Loading Textures" in chapter 14. 
 
Grabbing and Applying Attributes 
When you enter new text it is entered with the Current Text Attributes.  The text attributes specify how the characters, edges, and shadows 
will appear.  The Current Text Attributes are the attributes displayed in the Character, Edges, Shadows, and Colors control tab windows.  
These include the following: 
 
Typeface 
Character Size 
Italics and rotation angles. 
Kerning 
Blur (character and edge) 
Edge Style (type, depth, direction) 
Shadow Appearance (shape and offset) 
Colors (character, edges, and shadows) 
 
When you overwrite text, the text keeps the attributes of the text that you are overwriting.  If you would like to apply the Current Text 
Attributes to text that is already on the page, use the "Apply Text Attributes" command.  Select the text that you want to change the 
attributes of, and press the "Apply Text Attributes" button in the Shortcut Buttons window. 
 
If you want to grab the text attributes from text that is on the page, press the "Grab Text Attributes" button in the Shortcut Buttons 
window.  This will make the text attributes of the character under the cursor, the Current Text Attributes.  The new character attributes will 
then be displayed in the Character, Edges, Shadows, and Colors control tab windows. 
 
Text Style Gallery 
The "Text Style Gallery" window is used to hold preset text styles.  This is the window on the right side of your screen with all of the 
different type of "A's" in it.  The Text Style Gallery is designed to give you quick access to text styles that you will use frequently throughout 
the project.  You can save 64 different preset text styles in the Text Style Gallery.  However, you are not limited to just these 64 styles. 
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Before we begin, create a new page by pressing the "New Page" button on the toolbar.  The program will warn you that you are about to 
erase the current page.  Since we don't have a page that is really worth saving, press the "Yes" button.  If the program asks you which type 
of page to create, select "Still".  You now have a new blank page to work with. 
 
To enter text using one of the preset styles, select the desired text style (by clicking on it) and start typing.  Any new text that is entered will 
appear with the selected text style.  To select a different preset text style, click on it and start typing again. 
 
Select a text style that looks interesting and type "This is my first preset style".  Select another preset style and type "This is another one". 
 
To change the style of text that is already on the screen, select the text, then click on the style that you want to set it to.  Move the cursor to 
the first character and select another style from the style gallery.  Now, move the cursor to the next character and select another style.  
Continue to do this for every character of the first two words of the page. 
 
Select the word "first" by moving the mouse to the "f", press the left mouse button, and drag the mouse over to the "t" until the entire 
word is selected.  Then select another text style.  Notice that the entire word is changed. 
 
Select the Character tab in the Control Tabs Window and adjust the Height of the word "first".  Even though the character style was set 
using a preset style, you can still modify the style of the text.  So if you have a text style that is almost what you want, go ahead and select it, 
then modify the attributes of the text you just changed the style of, doing this will not affect the preset style in the style gallery. 
 
You can change the preset text styles.  Create a character on the page that has the style that you want to use as a preset, place the cursor on 
it, and move the mouse pointer to the entry in the Text Style Gallery that you want to set to this style, and press the right mouse button.  A 
pop-up menu will appear.  Select the "Set Style" command.  The text style of the cursor character will be copied to the style gallery. 
 
There are too many preset text styles to be shown at one time in the text style gallery.  You can use the scroll bar to scroll through the 
preset text styles.  I like to group styles that are used together, near each other in the Text Style Gallery. 
 
Save this page to the disk by pressing the "Save Page" button on the toolbar.  Give the page the name "STYLES" and press the "Save" 
button.  You should see its Picon in the project manager window. 
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Layers 
 

The Title Composer has 1000 layers available for text, shapes, and logos.  These layers are completely independent of each other.  Changing 
something on one layer will not affect the text on the other layers.  Each layer can be given a name.  Each layer can be moved in front of, or 
behind the other layers.  Individual layers can be temporarily hidden so that they do not cover up the other layers that you're working on. 
 
To work with layers, use the "Layer Controls" (shown below).  You can display these controls by selecting the "Layers” tab in the 
Controls Tab Window. 
 

 
 
Creating a New Layer 
Select a character height of about 48 scanline.  Enter enough text to fill the entire screen.  Move the mouse near the left margin about 
halfway down the screen.  Create a new layer by holding down the <Ctrl> key while you press the left mouse button.   
 
The cursor is now positioned where you clicked the mouse on the new layer.  Notice that the "layering order” list has a new entry called 
"layer 1".  This is the top layer in the list, so it will be the front layer on the screen.  Now enter the text "This is a new layer".  Notice 
that the new text appears in front of the original text.   
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Move the cursor to the second row of the text on the original (Main) layer by clicking the mouse on it.  Notice that the name of the “Main” 
layer appears on the current layer on the status bar.  Insert a row at the cursor position by holding down the <Shift> key while you press 
the <Ins> key.  The text on the Main layer moved down to make room for the new row of text.  The text on Layer 1 did not move.  That 
is what we mean when we say the layers are completely independent of each other. 
 
Selecting a Layer 
You can select a new layer just by setting the cursor position to a character that is on that layer.  Move the mouse to any character on Layer 
1 and click the left mouse button.  The cursor is moved to the character that you clicked with the mouse, and the status bar is updated to 
show that you are now on Layer 1. 
 
You can also select a new layer from the "Layering Order” list.  When this is done, the cursor will be placed on the first character of the 
selected layer. 
 
Renaming Layers 
When the new layers are created, they are given a default name such as "Layer 1".  When that layer is selected the name appears on the 
status bar and in the "Layer Name" box in the Layers Control Window.  You can change the name of the layer just by entering the new 
name in the "Layer Name” box.  When the name is changed, the name appears in the "Layering Order” list and on the status bar. 
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Changing Layer Priority 
When a new layer is created, it is given the highest priority so that it will be displayed in front of all the other layers.  The priority of each 
layer is displayed in the "Layering Order” list".  The top layer in the list is the highest priority layer and is in front of all the other layers on 
the page.  The bottom layer in the list is the lowest priority layer and is behind all of the other layers.  A layer is in front of all of the layers 
that are listed below it in the layering list, and behind all of the layers that are listed above it. 
 
Each layer can be moved in front of, or behind the other layers.  This can be done using the layer priority buttons (shown below). 
 
 

 

Move layer to top 
This gives the current layer the highest priority, and places it in front of all 
other layers 

 

 

Move layer up one layer 
This moves the current layer up 1 level in priority; this places it in front of the 
next layer up. 

 

 

Move layer down one layer 
This moves the current layer down one level in priority; this places it behind 
the next layer down. 

 

 

Move layer to bottom 
This gives the current layer the lowest priority, and places it behind all other 
layers. 

 
Dragging it from its current position to the new position in the “Layering Order” list can also change a layers priority.  Move the mouse to 
the layer that you want to change the priority of in the "Layering Order" list.  Hold down the left mouse button and drag the layers name 
to the desired priority.  The page will then be redrawn with the layer displayed at the new position. 
 
Hiding Layers 
When you start getting a lot of layers on a page, and you need to make a change to something that is on a low priority layer, the things that 
you want to change may be difficult to see because of the layers in front of it.  There are two ways to make the low priority of layers more 
visible.  One way is to increase the layers priority, edit the text, then move the layer back to its lower priority.  The other method is to "Turn 
Off" the layers in front.  This is done by telling the program which layers you don't want to see. 
 
On the right hand side of the Layers Control Window are 2 buttons (“Displayed” and “Hidden”).  These buttons show whether or not 
the current layer is displayed or hidden.  To hide a layer, select the layer that you want to hide and press the "Hidden" button.  The page is 
then redrawn without the selected layer.  To turn the layer back on, press the "Displayed" button, and the page is redrawn with the layer. 
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Another really neat thing that hidden layers allow you to do it is to easily create multiple pages that all have common information.  Place the 
text that is common to all pages on one or more layers.  Place text that is common to more than one (but not all) pages on other layers.  
Then compose the text that is unique to each page on its own separate layer.  This gives you a master page. 
 
Copy the master page once for each page that you want to create.  And hide the layers that you do not want to show on each individual 
page.  If you ever need to modify the text, you can modify the master page (instead of each individual page) then copy the pages and hide 
the appropriate layers again.  This avoids any differences (such as positioning errors) in the pages. 
 
Deleting Layers 
If a layer has no text on it, you may want to delete it.  You can do this by selecting the layer and pressing the "Delete Layer" button in the 
Layer Controls Window.  If there is text on the layer that you're trying to delete, a warning message (like the one below) will appear telling 
you that if you delete the layer, all of the text on that layer will also be deleted. 
 

 
 
If you want to delete the text that is on this layer, press the "Yes" button.  Otherwise press the "No" button.   
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Moving Text 
 
Once the text has been entered, it can be moved around and positioned.  This can be done either automatically or manually.  Automatic 
positioning of pages consists of word wrapping, word unwrapping, centering the text between the margins, justifying the text to the 
margins, or removing excess row spacing from between the rows. 
 
Manual positioning of the text allows you to move the text to nearly any position on the screen. 
 
To do automatic text positioning, use the “Positioning Controls” (shown below).  You can display these controls by selecting the 
“Positioning” tab in the Control Tab Window. 
 

 
 
Word Wrapping and Unwrapping 
Let's start with a fresh page by pressing the "New Page" button on the toolbar.  A warning may appear telling you that the current page is 
going to be erased.  If this happens press the "Yes" button.  Some system configurations will display a dialog box asking you to select the 
page type.  If this happens, press the "Still" button.  You now have a new page to work with. 
 
Set the character height to 48 scanline, and the character width to 100%.  Now enter the following text without pressing the <Enter> key 
"This Title Composer software is really pretty easy to use".  Notice that when you got to the right side of the screen, the cursor 
automatically went to the beginning of the next row. 
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Some of the words extend beyond the right margins.  There are two common methods of fixing this.  The first method is to make the text 
smaller so that it will fit.  The other method is to wrap the words that extend beyond the margin to the next row.  Since this section deals 
with word wrapping and unwrapping, let's try wrapping the words. 
 
The "Word Wrap/Unwrap" section of the "Positioning Controls Window" has four buttons.  These buttons are as follows: 
 

 
Wrap One Word 

 
Wrap All Words 

 
Unwrap One Word 

 
Unwrap All Words 

 
Word Wrap checks to see if the last word of the row extends beyond the right margin.  If it does, the word is moved to the beginning of 
the next row.  Word Unwrap checks to see if the first word of the next row will fit on the current row.  If it will, the word gets moved up to 
the row above. 
 
Move the cursor to the home position by pressing the <Home> key twice.  Press the "Wrap One Word" button (in the positioning 
controls window).  If the last word of the cursor row extends beyond the right margin, it gets moved to the next row. 
 
If there is a word that needs to be wrapped, one word gets wrapped to the next row each time you press this button.  If there is not a word 
that needs to the wrapped, pressing this button will move the cursor to the beginning of the next row.  Press the "Wrap One Word" button 
until all words that need it are wrapped to the next row and the cursor moves to the next row.  You could continue to wrap the entire page 
this way, but there is an easier way to do it.  Press the "Wrap All Words" button.  All of the words on the page that need to be word 
wrapped are moved to the next row. 
 
Select all of the text on the page by selecting "Entire Page" in the scope selection box on the toolbar.  Decrease the height of the text to 32 
scanline using any method that you prefer.  The rows of text got narrower so that you can now fit more text on each of the rows. 
 
Move the cursor back to the home position by pressing the <Home> key twice.  Press the "Unwrap One Word" button.  The first word of 
the next row should move up to the end of the cursor row if there's room for it.  Press the "Unwrap All Words" button.  Every word on 
the page will unwrap to fill in the excess space at the end of each row. 
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Row spacing (Leading) 
Notice that when you decreased the height of the characters that the height of the rows did not automatically get smaller.  The rows now 
seem to be spaced too far apart.  To set the row to the height that they should be, press the "Preset Row Spacing" button in the shortcut 
buttons window.  The height of each row will automatically adjust to what it should be for the height of the tallest character on the row. 
 
You can have more control over the rows spacing (leading) with the "Row Spacing" controls.  Display these controls (shown below) by 
selecting the "Row Spacing" tab in the control tab window. 
 

 
 
These controls are used to increase/decrease the spacing between the rows.  The row spacing can be increased by pressing the "More" 
buttons.  The row spacing can be decreased by pressing the "Less" buttons.  To set the row spacing back to what it should be (based on the 
text on the row) press the "Set Default Row Spacing" button. 
 
The buttons in the "Change Row Spacing of" section of this window are used to select which row(s) we are going to change the row 
spacing of. 
 

Changes the row spacing of the row that the cursor is on. 
 
Changes the row spacing of every row on the current layer. 
 
Changes the row spacing of every row on the page. 
 

Cursor Row 

Entire Layer 

Entire Page 
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Fine Positioning Text 
Individual characters, words, rows, layers, and the entire page can be fine positioned in single pixel/scanline increments.  Characters can be 
moved to any position on the row and can be made to completely overlap each other.  Smaller characters can be positioned inside of larger 
characters.  Rows can even be positioned to allow text to overlap the text of other rows. 
 
There are three ways to fine position text around the screen.  One method is to use the cursor handles.  Another method is to drag the text 
by moving the mouse while holding down the right mouse button.  The final method is to use the fine positioning buttons in the 
positioning control tab window. 
 
To use the cursor handles, select the character tab in the control tab window and turn the cursor handles on by pressing the “Cursor 
Handles” button.  Little rectangles will appear around the cursor.  These are the cursor handles.  The handle in the lower left hand corner 
will move the text both horizontally and vertically.  The handle on the left side of the mouse will move the text horizontally only.  Any 
accidental vertical movement of the mouse will not move the text vertically.  The handle on the bottom of the cursor will only move the 
text vertically.  Accidental horizontal movement of the mouse will not move the text horizontally. 
 
To move text with these handles, select the text to move by dragging the mouse over the desired text.  Position the mouse over the handle 
that you want to use and the cursor will change to arrows that show which direction the text can be moved.  Press and hold down the left 
button of the mouse, then move the mouse.  The text will follow the mouse until you release the left mouse button. 
 
If the Cursor Handles clutter up the screen too much for your taste, you can turn them off by pressing the “Cursor Handles” button again 
(once you are finished moving the text). 
 
You can quickly move the text (both horizontal and vertical) without turning on the cursor handles.  To do this, select the text that you 
want to move and press and hold down the right hand button of the mouse.  As you move the mouse, the text will follow it until you 
release the right mouse button. 
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To use the fine positioning buttons to move the text, display the Fine Positioning Buttons by pressing the "Positioning" tab in the control 
tab window.  This will display the Positioning Controls Window as shown below. 
 

 
 
Use these buttons to do fine incremental positioning of text.  The single arrow buttons will move the selected text one pixel each time you 
press it.  The double arrow buttons move the selected text in bigger steps. 
 
The "Reset Text Position" button will restore the text to its original (before it was moved) position. 
 
Centering and Justifying Text 
The Positioning Tab Window has 8 types of centering and justifying controls.  These are: 
 

 

Left Justify 
Notice how all of the lines are lined up with the left margin. 

 

Right Justify 
Notice how all of the lines are lined up with the right margin. 

 

Horizontal Centering 
Notice how all of the lines are centered between the left and right margins. 

 

Justify to Left and Right Margins 
Notice how all of lines are lined up with both the left and right margins. 

 

Vertical Centering 
The text is adjusted vertically to position it in the center of the screen. 

 

Center Horizontally and Vertically 
The text is adjusted horizontally and vertically to position it in the center of the screen. 

 

Top Justify 
The text is adjusted vertically so that the top row is placed at the top margin. 

 

Bottom Justify 
The text is adjusted vertically so that the bottom row is placed at the bottom margin. 
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The "Row" section of the "Positioning Controls Window" (shown below) has four buttons.   
 

 
 
These buttons are used to control individual rows of text.  Each row can be centered horizontally or justified to the left margin, right 
margin, or both margins at the same time. 
 
To center a row, place the cursor on the row that you want to center and press the "Horizontal Centering" button.  The row is now 
centered horizontally between the left and right margins. 
 
To justify the row to the right margin, press the "Right Justify" button in the "Row" section of the "Positioning Controls Window".  This 
moves the text to the right so that it is aligned to the right margin.  Press the "Left Justify" button in the "Row" section.  The text moves to 
the left so that it is aligned to the left margin. 
 
To justify the row to both margins at the same time, press the "Justify to Left and Right Margins" button in the "Row" section.  The first 
character of the row is placed at the left margin, and the spacing between the characters is adjusted so that the last character of the row is 
aligned to the right margin. 
 
To perform the centering and justifying functions on all of the rows of text on the page (or on the layer), use the corresponding buttons in 
the "Layer/Page" section of the "Positioning Controls Window" (shown below).   
 

 
 
This section has two buttons (Layer and Page) to select whether each operation will be done on every row on the layer or every row on the 
page. 
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Select the "Page" button to make the centering and justifying functions work on every row of the page.  Try pressing the "Horizontal 
Centering", "Right Justify", "Left Justify", and "Justify to Left and Right Margins" buttons in the "Layer/Page" section.  Notice that the 
functions are now done to every row on the page. 
 
Press the "Center Horizontal and Vertical" button (shown here) to center the entire page (or layer) both horizontally and vertically. 

 
 
Press the "Top Justify" button (shown here) to move the entire page (or layer) to the top margin. 

 
 
Press the "Bottom Justify" button (shown here) to move the entire page (or layer) to the bottom margin. 

 
 
Press the "Vertical Centering" button (shown here) to center the page (or layer) vertically between the top and bottom margins. 

 
 



C H A P T E R  5  -  M O V I N G  T E X T  

 58

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page intentionally left blank 
 



 

 59

 
 
 
 
 
 

Logos 
 
As many as 16 different full color logos can be placed on each page.  The logos can be loaded directly from GIF, TIF, TGA, BMP, PCX, 
JPG, or JPEG images.  If the image used as a logo has an alpha channel, the alpha channel is supported. 
 
To add a logo to a page, select the “Logos” tab in the Logos Controls Window.  The logo controls will be displayed as shown below. 
 

 
 
If the cursor is currently on a logo, information about that logo is displayed in this window.  The name of the image file that contains the 
logo is displayed.  This window also indicates the maximum size (height and width) that the logo can be displayed. 
 
Placing a Logo on the Page 
This window also has an "Add New Logo" button.  To add a new logo to the page, position the cursor where you want the logo to 
appear.  You may want to create a new layer for the logo, but you don't have to.  Press the " Add New Logo " button, and select the 
graphic image that you want to use as the logo.  The logo will then be displayed at the current character height.  Once a logo is added to a 
page you can size and edge it just like you would a character. 
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Sizing a Logo 
The maximum size that a logo can be displayed on a page is 640 by 480 pixels or the original size of the logo (whichever is smaller).  If a 
graphic image was created at 100 scan lines high, it cannot be displayed larger than 100 scan lines. 
 
When a logo is first loaded it is displayed at the current character height.  The "Maximum Height" and "Maximum Width" entries in the 
Logo Control Window will be updated to indicate the maximum height and width that this logo can be displayed. 
 
To change the size of a logo, position the cursor on it, and then change the size of it just as if it was a character.  You can use the "Height" 
and "Width" controls in the "Character Controls Window” to vary the logos height and relative width.  You can also use the cursor handles 
to change the logos height and width. 
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Shapes 
 
Shapes are boxes that you can control the roundness and the aspect ratio of.  Once the shape has been placed on the page you can size it, 
colorize it, add edges and shadows to it, and even rotate it.  In fact you can do anything to a shape that you can do to a character (except 
change the typeface of it).  A “Foreground Shape” gets inserted into the current layer at the cursor position.  A “Background Shape” 
gets added to a new layer that is automatically created behind the text that is currently selected. 
 
To create or edit a shape select the "Shapes" tab in the "Control Tabs Window".  The shape controls window will be displayed as shown 
below. 
 

 
 
Aspect Ratio 
The “Aspect Ratio” of the shape can be changed from tall and skinny to very wide.  The aspect ratio can also be changed by changing the 
relative width (using the Character Width Controls).  The character width does have a limited range of 10% to 500%.  The aspect ratio 
controls are used to extend this range. 
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Roundness 
The “Roundness” of the shape can be set to any value from 0 to 100%.  A Roundness of 0% creates a shape that has square corners.  A 
Roundness of 100% creates the shape that is either a circle or an ellipse (depending on its aspect ratio).  A value between 1 and 99% creates 
a box that has rounded corners.  The amount that the corners are rounded is determined by the Roundness setting. 
Foreground Shapes 
Add a foreground shape by moving the cursor to the desired position and press the "Add Foreground Shape" button.  The new shape is 
inserted at the cursor position.  The shape is assigned the Current Character Attributes.  To increase the width of the shape using the 
aspect ratio controls, drag the aspect ratio slider to the right.  To decrease the width, drag this slider to the left.  Use the “Roundness” 
control to adjust the roundness of the shape.  Dragging the “Roundness” slider to the right will make the shape rounder; dragging it to the 
left will make it squarer. 
 
Now that the shape is on-screen you can use the "Character", "Edges", "Shadows", and "Colors" controls to modify the various 
character attributes of the shape.  The program creates the shape as if it were a character.  All of the controls that can be used to change the 
appearance of a character can be used to change the appearance of a shape. 
 
Background Shapes 
Enter the words "Background Shape" on the page.  Drag the mouse across all the characters of both words to select them.  Now press 
the "Add Background Shape" button.  A new shape is created behind the selected text.  A new layer was automatically created for this 
shape and placed behind the text. 
 
This shape is exactly like the foreground shape except that it's on a separate layer.  You can change the character attributes just like you can 
a foreground shape or a character. 
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Background Color Boxes 
 
The Title Composer can display background color boxes over the background image (or external video) and behind the text.  Each 
background color box can be positioned and sized to anywhere on the screen.  The color box can be set to a solid color, a smooth color 
spread between the top and bottom of the box, a color gradient (a four or five point area gradient, or a linear gradient with up to 16 colors), 
or a full color texture.  If the background color boxes have a solid color, a color spread, or a color gradient, the transparency and 
background video levels of each color point can be adjusted. 
 
As many as 32 background color boxes can be used on each page.  Each background color box is assigned to its own layer.  The 
background color layers are always behind the text layers and in front of the background image.  The priority that each background color 
box is assigned determines how they will appear when one background color box overlaps another.  A background color box that has a 
higher priority will appear in front of color boxes that have lower priorities. 
 
 To create or edit a background color box select the "Background-Colors" tab in the Control Tabs window.  The Background Color 
Box Controls (shown below) will be displayed. 
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Creating a New Background Color Box 
To create a new background color box press the "New Background Color Box" button.  A new color box will appear behind the cursor 
row.  The background color box begins as a semi-transparent gray that is the full width of the screen, and the height of the cursor row. 
 
The cursor appears to surround the new background color box.  The cursor has six cursor handles.  Three of these handles (on the left and 
bottom of the cursor) are used to position the color box.  The other three handles (on the top and right of the cursor) are used to size the 
color box. 
 
Moving and Sizing Background Color Boxes 
Use the handle at the top of the cursor to adjust the height of the color box.  Use the handle on the right side of the cursor to adjust the 
width of the color box.  Dragging the handle on the upper right corner of the cursor will adjust both the height and width of the color box. 
 
You can move the Background Color Box in any direction by clicking on the handle in the lower left corner of the cursor and dragging the 
mouse.  If you want to move the color box horizontally only (without moving it vertically) use the handle on the left side of the cursor.  The 
handle on the bottom of the cursor will move the color box vertically (without changing the horizontal position). 
 
Changing Background Color Box Color 
There are five different ways of selecting a color for the background color box.  These methods are as follows: 
 
Color Picker 
The color picker lets you select the color using a visual approach. 
 
Color Sliders 
The color sliders let you select a color using a numerical approach. 
 
Color Palette 
The color palette lets you select a color from a palette of 64 (User Definable) preset colors. 
 
Color Gradient 
A color can be selected from a group of 64 user-defined color gradients.  These may be either a linear gradient with up to 16 color points 
that can be rotated up to 90 degrees in either direction, or an area gradient that can have four or five color points defined. 
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Color Texture 
A color texture can be selected from any of the 16 textures that are currently loaded. 
 
Color Picker 
Press the "Picker" button to display the color picker controls.  The color picker controls are shown below. 
 

 
 
The top and bottom of each background color box can be set to different colors.  There are two boxes to select whether we want to change 
the top color, the bottom color, or both.  If the top and bottom colors are different, the color box will be drawn with a smooth color 
spread between the two colors.  The top and bottom transparency and background video levels can also be set independently. 
 
Below these check boxes is an Illegal Color Indicator.  If the selected color exceeds NTSC or PAL limitations, this box will appear red to 
indicate that you have selected an illegal color.  Otherwise this box will appear green. 
 
Below the Illegal Color Indicator is the "Pick Color From Screen" button.  Pressing this button will change the appearance of the 
mouse cursor to look like an eyedropper.  Move the mouse to any position on the screen that you want to copy the color of, press left 
mouse button and the color under the mouse will be selected. 
 
To the right of these controls is the Hue Picker.  This is used to select the hue (red, green, blue, etc.) of the color.  Place the mouse over 
this control, and press the left mouse button to select the desired Hue.  When the new hue is selected, the background box will be redrawn 
with the new color, and the Color Picker Area (to the right of the Hue Picker) will also be drawn with the new hue. 
 
Once the hue is selected you can now pick a color.  Place the mouse over the Color Picker Area and press the left mouse button.  This 
will select the color under the mouse.  If you hold down the left mouse button while you move the mouse around the Color Picker Area, 
the background color box will be redrawn with the new color each time you select a new color by moving the mouse. 
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You can also control the Transparency of the color.  The Transparency setting can make the color fully opaque, semi-transparent, or 
fully transparent.  When a color is semi-transparent, the text component is drawn tinted over whatever is behind it.  When the color is fully 
transparent, it can't even be seen on-screen.  Setting the transparency level to 0 makes the object fully opaque.  Setting the level to full (255) 
makes the object fully transparent.  Any value in between makes a color that is semi-transparent. 
 
There are a variety of ways to change the Transparency level.  Pressing the increase button to the right of the transparency number box 
can increase the level.  If you hold this button down, the level will continue to increase until you release the button.  To decrease this value, 
press the decrease button.  Holding down this button will continue to decrease the value until it is released.  If you move the mouse over 
the transparency number box, then press and hold down the left mouse button, you can change the value by moving the mouse.  Moving 
the mouse up or to the right will increase the value.  Moving the mouse down or to the left will decrease the value.  When you have selected 
the desired value, release the left mouse button. 
 
The value of the transparency level can be entered directly.  Do this by double-clicking the transparency number box (this will highlight all 
of the digits in the number), type in the new value and press the enter key. 
 
The color can be also mixed with background video.  Setting the video level to a value of 0 makes the object the selected color.  Setting the 
video level to full (255) draws the object with background video.  Any value in between makes the object appear as background video that is 
tinted by the selected color.  For some very interesting effects, try blending colors, background video, and transparency over a background 
graphic image. 
 
The background video level can be adjusted in the same way as the transparency level. 
 
Color Sliders 
Press the "Sliders" button to display the Color Slider Controls.  The Color Slider Controls are shown below. 
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The top and bottom of each Background Color Box can be set to different colors.  There are two check boxes to select whether we want to 
change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top and bottom colors are different, the Background 
Color Box will be drawn with a smooth Color Spread between the two colors. 
 
Below these check boxes is the Illegal Color Indicator.  If the selected color exceeds the NTSC or PAL limitations, this box will appear red 
to indicate that you have selected an illegal color.  Otherwise this box will appear green. 
 
The Title Composer has two (2) numerical systems for defining colors.  They are RGB (Red, Green, Blue) and HLS (Hue, Luminance, 
Saturation).  Both of these systems are used to define the same thing (like yards and meters).  Adjusting one will automatically change the 
other.  You can select which method to use by pressing either the RGB or HLS button.  You can switch back and forth between the 2 
color systems at any time just by pressing the appropriate button. 
 
The RGB and HLS values can be adjusted by dragging the sliders, or by double-clicking the number box and entering the new value with 
the keyboard.   
 
Color Palette 
Press the “Palette” button to display the color palette.  The Color Palette is shown below. 
 

 
 
The preset Color Palette can hold 64 preset colors.  These preset colors are displayed in this window.  Not all of the preset colors can be 
displayed at one time, so there is a scroll bar on the right hand side of the color palette entries.  Use this scroll bar to scroll through all of 
the preset colors. 
 
The top and bottom of each Background Color Box can be set to different colors.  There are two check boxes to select whether we want to 
change the Top Color, the Bottom Color, or both the top and bottom colors.  If the top and bottom colors are different, the Background 
Color Box will be drawn with a smooth Color Spread between the two colors.   
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Below these two check boxes is the Illegal Color indicator.  If the selected color exceeds the NTSC or PAL limitations, this box will 
appear red to indicate that you have selected an illegal color.  Otherwise this box will appear green.   
 
To select a color from the preset color palette, position the mouse over the desired color and click the left mouse button.  You can change a 
color in the preset Color Palette by double clicking the entry that you want to change.  For more information about modifying the preset 
Color Palette, see the section "Modifying the Color Palette" in chapter 14. 
 
This window also has a button labeled "Background Video".  Pressing this button will set the color so that the Background Color Box 
will be drawn with background video. 
 
Color Gradients 
Press the "Gradient" button to display the color gradient selection window.  The Color Gradient selection window is shown below. 
 

 
 
64 color gradients can be created for each project.  The Color Gradients that are currently set are displayed in this window.  Not all of the 
color gradients can be displayed at one time, so there is a scroll bar on the right hand side of the Color Gradient entries.  Use this scroll bar 
to scroll through all of the color gradients currently set for the project. 
 
To select a color gradient, position the mouse over the desired gradient and click the left mouse button.  The Background Color Box will 
then be drawn with the selected color gradient.  You can edit a Color Gradient, or build a new one, with the gradient builder.  To do this, 
double-click the Color Gradient that you want to modify.  For more information about using the gradient builder, see the section "Building 
Color Gradients" in chapter 14. 
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Color Textures 
Press the "Textures" button to display the Color Textures selection window.  The Color Textures selection window is shown below. 
 

 
 
16 full Color Textures can be loaded into the system at one time.  The Color Textures that are currently loaded are displayed in this 
window.  The Textures are displayed large enough so that you can easily see what the texture looks like.  Not all 16 textures can be 
displayed in this window at one time, so there is a scroll bar on the right hand side of the textures.  Use this scroll bar to scroll through all 
of the textures that are currently loaded. 
 
To select a Color Texture, position the mouse over the desired texture and click the left mouse button.  The Background Color Box will 
then be drawn with the selected texture.  You can load a new texture by a double-clicking on the one that you want to replace.  When this is 
done you will be asked to specify which graphic image you want to load as a texture.  For more information about loading graphic images as 
Color Textures, see the section "Loading Textures" in Chapter 14. 
 
Full-Screen Background Color 
To create a background color box that covers the full-screen, press the "Full Screen Background Color" button.  A new background 
color box (that is a semi transparent gray) will be created that covers the entire page. 
 
Selecting Background Color Box 
You can only edit one background color box at a time.  Before you can modify a background color box you need to select it.  The selected 
color box is displayed with a cursor (rectangular box) around it.  The cursor also has six small boxes attached to it.  These are called cursor 
handles, they are used to size and position the background color box. 
 
Background color boxes can be selected by clicking the mouse on the desired one.  If more than one background color box overlap, keep 
clicking the left mouse button until the one you want is selected. 
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Changing Color Box Priority 
Each color background box is placed on its own separate layer (behind the text layers and in front of the background graphic image).  The 
priority of each background color box determines how it will appear when one color box is overlapped by another.  The background color 
boxes that have a higher priority will appear in front of color boxes that have a lower priority. 
 
The background color controls have four buttons that are used to change the priority of the background color boxes.  These buttons allow 
you to move the background color boxes in front of, or behind other color boxes when they overlap.  These buttons are shown below. 
 

 

Press this button to move the current background color box to the highest priority.  When this is done it will 
appear in front of all other background color boxes. 

 

Press this button to increase the priority of the current background color box by one.  This will place the color 
box in front of the color box that had the next higher level of priority (if they overlap). 

 

Press this button to decrease the priority of the current background color box by one.  This will place the color 
box behind the color box that had the next lower level of priority (if they overlap). 

 

Press this button to move the current background color box to the lowest priority.  When this is done it will 
appear behind all of the other background color of boxes. 

 
Converting a Background Color Box to a Shape 
A background color box can be converted to a shape by pressing the "Convert Color Box to Shape" button.  When this is done the 
color box is placed in front of all the other background color boxes.  Once a background color box has been converted to a shape, it cannot 
be converted back to a Background Color Box. 
 
When a background color box is made into a shape, it can be italicized, rotated, and rounded just like any other shape.  It can also have 
edges and shadows added to it just like any other character. 
 
Deleting a Background Color Box 
To remove a background color box from the page, select the background color box that you want to delete by positioning the mouse over 
it and clicking the left mouse button.  Once it is selected, press the "Delete Background Color Box" button.  This will delete the current 
background color box. 
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Background Images 
 
The program can display either a graphic image or a background video source (provided your system is capable of overlying titles over 
video) behind the text.  The background graphic can be in any of the following graphic formats: 
 
Windows bitmap (BMP) 
TIFF 
Targa (TGA) 
PCX 
GIF 
JPG 
JPEG 
 
These are standard graphic formats that can be generated by many third party software packages.  If no background graphic image is 
selected, the text will be overlaid over the background video source (if your system is capable of this). 
 
A background graphic can be displayed in either original size, scaled to fill the entire screen, or tiled to fill the screen.  When the graphic is 
displayed with its original size, it may or may not fill the entire screen.  When a graphic is displayed full-screen, it is scaled (either up or 
down) to match the screen dimensions.  When the graphic is tiled, it is displayed in its original size and is repeated enough times to fill the 
entire screen. 
 
To change the background image, select the "Background - Image" tab In the Control Tabs window.  The Background Image 
Controls (shown below) will be displayed. 
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No Graphic (Background Video) 
Special hardware or software (if the program is running as a plug in) is required to overlay the titles over video.  Some systems are not 
capable of this.  If your system is not capable of overlaying titles over video, the background will be displayed as black. 
 
To overlay the title over background video, press the "No Graphic (Background Video)" button.  Any background graphic that may 
have been displayed will disappear and the text will be displayed over the background video. 
 
Graphic - Original Size 
When you load a graphic to be displayed in its original size, the graphic may be smaller than the screen, the same size as the screen, or larger 
than the screen.  To load a graphic in its original size, press the "Graphic-Original Size" button.  A window will appear asking you to 
select the Background Graphic.  Select the graphic image that you want to load as a background and press the "Open" button.  The 
selected graphic will be loaded. 
 
If the graphic is smaller than the screen, it will be centered on the screen, and the positioning buttons that are used to change graphic 
position will be displayed. 
 
If the graphic is the same size as the screen, it will be displayed as a full-screen image.  If the graphic is larger than screen, a warning 
message (like the one shown below) will appear. 
 

 
 
At this point you have the option of shrinking the graphic so that the entire image will fit on the screen, or displaying the graphic in its 
original size and cutting off the outside edges of the graphic.  To display the graphic without shrinking it, press the "No" button.  The new 
graphic will then loaded as the background. 
 
To shrink the background graphic so that all of it will be displayed, press the "Yes" button.  This will load the graphic "Full-Screen".  See 
the section below (Graphic-Full Screen) for more information. 
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Graphic - Full Screen 
When you load a graphic to be displayed full-screen, and the original size of the graphic is not the same as screen dimensions, the graphic 
must be scaled before it will fit the screen.  If the graphic is smaller than the screen, it will be enlarged.  If the graphic is larger than the 
screen, it will be reduced in size. 
 
A video screen has a fixed aspect ratio of 4 by 3 (or 16 by 9).  This means that the screen wider than it is tall.  If the background graphic 
image has a different aspect ratio (maybe it's taller than it is wide), the height and the width will need to be scaled by different amounts to 
make the image fill the entire screen.  This can distort the image.  It can make people look very fat, or very tall. 
 
Before the background image is loaded full-screen the aspect ratio of the graphic is checked to see if it matches the screens aspect ratio.  If 
the aspect ratios are different, a warning message (like the one shown below) is displayed. 
 

 
 
If you choose to preserve the aspect ratio, the background graphic will be scaled horizontally and vertically by the same amount.  This will 
prevent the image from being distorted.  However the graphic will not fill the screen both horizontally and vertically. If the image is too tall, 
it will not fill the screen horizontally.  If the image is too wide, it will not fill the screen vertically. 
 
If you choose not to preserve the aspect ratio, the background image will be scaled horizontally and vertically the amount necessary to fill 
the entire screen.  If this results in unacceptable distortion, simply load the background graphic again.  This time preserve the aspect ratio. 
 



C H A P T E R  9  -  B A C K G R O U N D  I M A G E S  

 74

Graphic - Tiled 
If a graphic image is smaller than the screen, it can be tiled in the background.  This will display the background graphic in its original size.  
The graphic will be repeated horizontally and vertically to fill the entire screen. 
 
To tile a background graphic, press the "Graphic - Tiled" button. A window will appear asking you to select the background graphic.  
Select the graphic image that you want to load as a background and press the "Open" button.  The selected graphic will be loaded and tiled. 
 
If the graphic is larger than the screen, a warning message (like the one shown below) will appear. 
 

 
 
At this point you have the option of shrinking the graphic so that the entire image will fit on the screen, or displaying the graphic in its 
original size and cutting off the outside edges of the graphic.  To display the graphic without shrinking it, press the "No" button.  The 
graphic will then be loaded as the background.  Portions of the graphic image will be cut off. 
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Projects and Pages 
 
Project Settings 
Projects are a convenient way of keeping groups of pages and project settings separate from each other.  When a new project is created 
Title Composer creates a new folder (with the same name as the project) on your system.  Whenever you are working in this project, the 
pages will be read from and written to this folder as the default.  All pages that are in this folder will appear in the Project Manager window. 
 
The system default settings are saved in the project file.  This file has the same name as the project with a .SET extension (for example, the 
project MY_PROJECT would be defined in a file called MY_PROJECT.SET).  This file contains the following system default settings: 
 
• Character Attributes 
• Style Gallery 
• Color Gradients 
• Default Color Palette 
• Loaded Typefaces 
• Loaded Textures 
• Default Directory/Folders 
• Safetitle Margins 
• Tab Settings 
 
When a new project is created, the current system settings are saved as the Project Defaults.  When the project is opened again, these 
settings will be restored as the default settings. 
 
You can update the default settings of the project by selecting the "Save Project Settings" command in the "File" menu.  The current 
systems settings will be saved as the Project Defaults. 
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When you exit the program, or you open another project, a message window may appear (depending on your Preference Settings) asking 
you if you want to save the current settings.  This window is shown below: 
 

 
 
If you press the "Yes" button, the project settings will be updated to match the current settings. 
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Project Manager 
The Project Manager is used to give you quick access to all of the pages in the project.  This window (shown below) is on the left hand 
side of the screen. 
 

 
 
All of the pages in the current project are displayed in this window.  The pages are represented both by Picons and the name of the pages.  
A PICON (Picture ICON) is a miniature picture of the page.  With Picons you can tell at a glance what the page looks like.  You can open 
any page in the project just by clicking on it in the Project Manager window.  If there are too many pages in the project to be displayed at 
one time, you can scroll through the list of pages using the Project Managers scroll bar. 
 



C H A P T E R  1 0  –  P R O J E C T S  A N D  P A G E S  

78 
 

Pages can be created, opened, saved, copied, deleted, and exported from the menu that appears when you position the mouse over the 
project manager and click the right mouse button.  This menu is shown below. 
 

 
 
Some systems may not support rolls and crawls.  If your system does not, the appropriate menu entries will not appear.  This menu also has 
commands for creating a New Project, Opening an existing Project, and Saving the current settings as the Project default Settings.  These 
menu commands can also be selected from the "File" menu. 
 
Creating a New Project 
When a new project is created, the current systems settings are saved as the new project defaults.  So, before you create a new project, you 
should open an existing project that has systems settings similar to the default system settings that you want the new project to have. 
 
To create a new project, select the "New Project" command from the "File" or “Project Manager” menu's.  When this is done a 
window (like the one shown below) is displayed. 
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Enter the name of the new project where it says "New Project Name" and press the "Create" button.  The name of the new project now 
appears at the top of the project manager.  Since we haven't created any pages for the new project yet, no pages appear in the list.  As you 
create pages for this new project they will appear in the Project Manager window. 
 
Open an Existing Project 
To open a project that already exists, select the "Open Project" command from the "File" or Project Manager menus.  Once this is done 
the "Load New Project Settings" window (shown below) will appear. 
 

 
 
Use this window to select which project to open and press the "Open" button.  When the new project is opened, the new project’s system 
settings will be loaded.  The old project settings will be overwritten.  Before the old project settings are lost, you may be given the chance to 
save them (if the User Preferences are set accordingly).  If so the following window will appear. 
 

 
 



C H A P T E R  1 0  –  P R O J E C T S  A N D  P A G E S  

80 
 

You can save the old system settings to the old project file by pressing the "Yes" button.  Pressing the "No" button will open the new 
project without saving the system settings. 
 
Once the new project is opened, the pages in the project will appear in the Project Manager window. 
 
Save Project Settings 
To save the current settings as the project defaults, select the “Save Project Settings” command from the “File” or Project Manager 
menus.  The current project settings will be saved to the Settings (.SET) file so that they can be restored the next time this project is 
opened. 
 
Pages 
When pages are saved on the disk, they are each saved in a separate file.  The sizes of these files are determined by the amount of text and 
the complexity of the page.  Most pages are smaller than 1 or 2 Kbytes unless they contain logos or textures.  Hundreds of pages can be 
stored on a floppy disk and millions can be stored on a hard drive.  Each page file can be given a unique name.  The “.PAG” extension is 
added to the page name to create the file name that the page will be stored under. 
 
The pages are stored in a format that allows them to be fully edited, even after they are saved.  You don’t need to worry about things 
getting “locked down” after the page has been saved.  The pages can also be saved in both Windows Bitmap (BMP) and Targa (TGA) 
formats.  This lets you use the Title Graphics that you create in other graphics programs.  Saving the page as one of these graphics formats 
automatically saves it in the Page (PAG) format as well.  This keeps the page in a format that can still be edited (Have you ever tried to 
correct the spelling of a word in a Bitmap?). 
 
All information needed to display the page is stored in the page file except for the Typefaces and the background graphic.  When a page has 
a Logo or multiple Logos on it, the logo is stored in the page file.  This is done to speed up the Page Recall time.  The page file does keep 
track of which background graphic and typefaces are used in the page.  When a page is recalled, the system will automatically load the 
needed typefaces and the background image. 
 
When a page is saved or recalled, the dialog box first displays with the default page directory.  You can select another directory to save the 
page to or recall it from. 
 
The default page directory can be changed.  See the section “Default Directories” in Chapter 14 for more information on how to do this. 
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Creating a New Page 
Please Note:  some systems may not support rolls and crawls.  If your system does not, the appropriate menu entries will not be displayed in the menu. 
 
To create a new page, use one of the following commands: 
 
Press the “New Page” button on the Toolbar. 
Select the “New Page” entry from the “File” menu. 
Select the  “New Still Page” entry from the “File” menu. 
Select the “New Roll Page” entry from the “File” menu. 
Select the “New Crawl Page” entry from the “File” menu. 
Press and hold down the <Ctrl> key while pressing the <N> key. 
 
When this is done the process of creating a new page will begin.  If the “Automatically Save Pages” setting in the “User Preferences” 
dialog box requires it, the following message box will appear. 
 

 
 

 
The system can only have one page opened at a time.  When you open a new page, the old page (or any changes made to it) will be 
discarded unless it is saved to the disk.  If you want to save the changes to the old, page press <Yes>, otherwise press <No> and the 
changes will be discarded. 
 
If the page was not saved, the following warning will appear: 
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If you do not want to lose the changes to the current page, press the “No” button to cancel the New Page operation.  You can then save 
the old page. 
 
If you press the “Yes” button, all of the text and background will be erased from the screen.  If you did not use a command that specified 
the page type, the “Select the Page Type” dialog box (shown below) will appear.   
 

 
Select the Page type dialog box 

 
Some systems may not support rolls and crawls.  If your system does not, the appropriate buttons will be disabled.  Use this box to select 
which type of page you want to create.  This gives you a fresh page to start with. 
 
Opening an Existing Page 
Opening a new page will overwrite the page that is currently open.  Make sure that you save any changes to the current page that you want 
to keep before opening a new one. 
 
To open an existing page, use one of the following commands: 
 
Select it from the listed pages in the Project Manager window. 
Select the “Open Page” entry from the “File” menu. 
Press the “Open Page” button in the Toolbar. 
Press and hold down the <Ctrl> key while pressing the <O> key. 
 
If the “Automatically Save Pages” setting in the “User Preferences” dialog box requires it, the following message box will appear. 
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The system can only have one page opened at a time.  When you open a new page, the old page (or any changes made to it) will be 
discarded unless it is saved to the disk.  If you want to save the changes to the old page press “Yes”, otherwise press “No” and the changes 
will be discarded. 
 
Once this is done the Open Page dialog box (shown below) will appear. 
 

 
Open Page dialog box 

 
Use this dialog box to select which page to open.  Once a page is opened it will appear in the “Title Compose” window.  You can now edit 
the page. 
 
Saving a Page 
When you are finished editing a page, you need to save it to the disk.  To do this, select the “Save Page” entry from the “File” menu (or 
press the “Save Page” button on the Toolbar).  If the page already has a name, it will be saved back to the disk under the old name.  If 
the page does not yet have a name, the Save Page As dialog box will appear (see Saving a Page with a New Name) so that you can name the 
page. 
 
Every once in a while, while editing a page you should save it to disk.  This protects your work from things like power failures.  This 
function can be accomplished by holding down the <Ctrl> key and pressing <S>. 
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Saving a Page with a New Name 
To save a page with a new page name, select the “Save Page As” entry from the “File” menu.   
 
When this is done, the Save Page As dialog box (shown below) will appear. 
 

 
Save Page As dialog box 

 
Use this dialog box to select a name for the page.  The “Save as type” control allows you to select which format you would like to save 
the page as.  This can be any of the following: 
 
• Page (*.PAG) 
• Windows Bitmap (*.BMP) 
• Targa format (*.TGA) 
 
Some systems may also have other formats to choose from. 
 
If you save the page as either a Windows Bitmap or Targa format file other graphics programs can use the image.  Since text stored in these 
formats cannot be edited (without a great deal of difficulty), the page will also be saved in the “Page (*.PAG)” format.  This keeps the page 
in a format that you can edit. 
 
If the page is saved under a new name, the old page will remain on the disk under the old page name. 
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Deleting a Page from the Disk 
Before you can delete a page from the disk you must use the Open Page function to recall the page to the screen.  This forces you to “look 
at it” to make sure it’s the right page before you delete it.  Once the page has been opened, select the “Delete Page” entry from the 
“File” menu.  A warning such as the one below will appear. 
 

 
 
The second line in the warning box shows the directory and page name of the page about to be deleted.  If you don’t want to delete this 
page, press the “No” Button.  Pressing the “Yes” button will delete the page from the disk.  Once this is done you will not be able to open 
the page again. 
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Export Page 
Many systems need to have the title pages exported in a particular graphics format.  In most instances this is the Targa (TGA) format 
(although some systems require a Proprietary format).  The file format of the exported Title Graphics can be set using the “User 
Preferences”. (See Chapter 14 for more information). 
 
The Title Graphic can also be exported to the Windows Clipboard.  When a Title Graphic has been exported to the clipboard, other 
graphic programs can used it by using the “Paste” function. 
 
To export a page, press the "Export Page" button in the shortcut buttons window.  The page must be named before it can be exported.  
If the page is not named, a message (like the one below) will appear to remind you to give the page a name.  Once the page is named, you 
can then export it.  The exported image will have the same name as the page you are exporting (except with a different file extension).  For 
example: if the page were export in Targa (TGA) format under the name "TITLE.PAG", the image file would be saved as "TITLE.TGA". 
 

 
 
If you press the “OK” button the “Save Page As” dialog box will appear to allow you to give the page a name. 
 
The page can also be exported by selecting the "Export Title Graphic" command from the "File" or "Project Manager" menus. 
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Page Transitions 
 

When pages are shown ON AIR, each page can be displayed with some sort of page transition.  There are a number of different Page 
Transition Types to choose from.  You can control how long the Page Transition takes by setting the Transition Duration.  Each page can 
be set to different Transition Type, Transition Duration, and Dwell Duration.  This lets you intermix different transition types and 
durations in a sequence of pages.  For example: one page can roll onto the screen fast, and the next page can wipe on slowly.   
 
These three page attributes (Transition Type, Transition Duration, and Dwell Duration) are saved with the page.  Be sure to set these 
page attributes before saving the page. 
 
Not all Transition Types are available in all systems.  Some Transitions require capabilities that are not available in all display cards.  The 
Page Transition Type drop down box will display the Page transitions that are available on your system. 
 
To set the Page Attributes, select the “Page Transitions” tab in the Control Tabs Window.  The controls for setting the Page Attributes will 
then be displayed as shown below. 
 

 
 

Chapter 
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Page Transition Type 
There are different categories of page transitions for the program.  Some categories have only 1 transition type (such as Cut).  While other 
categories have many transition types (such as block transition with 57 types).   
 
The Page Transition Type drop down box displays the current transition type.  It is used to select the new transition type.  The drop down 
box lists every category of transition type available.  If there is only one transition type in a category, the name of the transition is listed.  
Selecting this from the list will select this as the transition type.  If there are multiple transition types in the category, the name is followed 
by 3 dots (...).  Selecting this from the list will display another window so that you can be more specific about which transition type you 
want to select. 
 
Once a Page Transition type is selected, it will appear in the Page Transition Type box.  For a detailed description of each Page Transition 
type, see the section Transition Types later in this chapter. 
 
Transition Duration 
The Transition Duration specifies how much time it takes to perform the page transition.  This controls how fast the page displays when 
the page is displayed ON AIR.  The duration is specified in frames.  In NTSC a frame is 1/30 of a second.  In PAL a frame is 1/25 of a 
second. 
 
To change the Transition duration, select the Transition Duration box (using either the keyboard or the mouse) and enter the new value. 
 
Dwell Duration 
The Dwell Duration specifies how long the page will remain on the screen when automatically sequencing pages.  The duration is specified 
in seconds.  To change the Dwell duration, select the Dwell Duration box (using either the keyboard or the mouse) and enter the new 
value.  This value is ignored when manually controlling pages. 
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Transition Types 
The categories and the number of transition types they contain are listed below: 
 
 
Category 

Number of Transition 
Types 

  1-Cut   1 
  2-Crawl   1 
  3-Roll   1 
  4-Wipe   8 
  5-Block 57 
  6-Iris 18 
  7-Sparkle   1 
 
The following is a brief description of each transition type in each category. 
 
Cut 
When a page is shown with a Cut transition type it comes on immediately (all at once).  With a Cut transition type the Transition Duration 
is meaningless. 
 
Crawl 
When a page is displayed with a Crawl transition type, it moves from right to left across the screen at a speed required to show all of the 
text in the time specified by the Transition Duration.  For more information about Roll & Crawl speeds, see the section titled “Roll and 
Crawl Speeds” below. 
 
Since a crawl is one long row, every row except the top one will disappear.  You will not be able to move the cursor off of this row.  The 
crawl row is always the top row of the page.  If you want the crawl to appear in a different position on the screen, use one of the following 
commands to change the row position: 
 

• Move the row by selecting the “Fine Position Text...” entry from the “Positioning” Control tab. 
• Justify the page to the bottom margin by pressing the “Bottom Justify” entry from the “Positioning” control tab. 
• Set the Lower Third Mode by selecting the “Lower Third Mode” entry from the “Settings” menu. 

 
After the Page transition type has been set to Crawl, the system enters the crawl compose mode.  In this mode, moving the cursor beyond 
the right margin will scroll the row to the left.  Moving the cursor beyond the left margin will scroll the row to the right. 
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Credit Roll (variable length) 
A credit roll page rolls onto the screen starting from the bottom.  The page moves up the screen at the speed required to show all of the 
text in the time specified by the Transition Duration.  The top of the page disappears off the top of the screen as the rest of the page 
appears on the bottom of the screen. 
 
A Credit Roll can be up to 1000 rows long.  Of course, that many rows can’t appear on the screen at one time.  When composing a credit 
roll, if you move the cursor below the bottom margin, the page will scroll up to expose more of the roll text.  If you try to move the cursor 
above the top margin, the page will scroll down. 
 

R O L L  A N D  C R A W L  S P E E D S  

Because of the interlaced nature of video, only certain roll and crawl speeds will appear smooth.  For a Roll or Crawl to show in the time 
specified by the Transition Duration, the required speed could be jerky.  To solve this problem, the roll and crawl will start at the next 
slower speed that is smooth.  As it displays at the slower speed it will get behind.  It will continue to run at the slower speed until it is far 
enough behind that running at the next faster speed (that is smooth) will make it end at the right time. 
 
Wipes 
When “Wipes...” is selected from the Page Transition Type control, the “Wipe Transitions” window (shown below) will appear. 
 

 
 
This window shows the various wipe transitions.  There are 8 different types of Wipe Transitions.  These are: 
 

W I P E  F R O M  T O P  T O  B O T T O M  

The new page begins to appear at the top of the screen and wipes down toward the bottom of the screen.  The new page covers the old 
page. 
 

W I P E  F R O M  B O T T O M  T O  T O P  

The new page begins to appear at the bottom of the screen and wipes up towards the top of the screen.  The new page covers the old page. 
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W I P E  F R O M  L E F T  T O  R I G H T  

The new page begins to appear at the left side of the screen and wipes towards the right side of the screen.  The new page covers the old 
page.   
 

W I P E  F R O M  R I G H T  T O  L E F T  

The new page begins to appear at the right side of the screen and wipes towards the left side of the screen.  The new page covers the old 
page. 
 

W I P E  I N  F R O M  T O P  &  B O T T O M  

The new page begins to appear at both the top and bottom of the screen and wipes in towards the center of the screen.  The new page 
covers the old page. 
 

W I P E  O U T  F R O M  T O P  &  B O T T O M  

The new page begins to appear at the center of the screen and wipes up and down towards the top and bottom of the screen.  The new 
page covers the old page. 
 

W I P E  I N  F R O M  T H E  S I D E S  

The new page begins to appear at both the left and right sides of the screen and wipes in towards the center of the screen.  The new page 
covers the old page. 
 

W I P E  O U T  T O  T H E  S I D E S  

The new page begins to appear at the center of the screen and wipes both left and right towards both sides of the screen.  The new page 
covers the old page. 
 
Select the desired wipe transition and the type of wipe that is selected will appear in the Page Transition Type drop down box. 
 
Block Transitions 
When “Block...” is selected from the Page Transition Type control, the “Block Transitions” window (shown below) will appear: 
 

 
Block Transitions window. 
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This window lets you select the various Block Transitions.  There are a total of 19 different types of block transitions, and 3 different sizes 
of blocks, for a total of 57 different Block display types:  The basic block transition types are: 
 

R A N D O M  

The blocks that make up the new page come onto the screen randomly in small rectangles that cover the old page.  Select this transition 
type by selecting the “Random” button in the “Reveal Type” group. 
 

S P I R A L  I N  

The blocks that make up the new page start to appear at the upper left corner.  These blocks are added to the screen in a Spiral In pattern 
towards the center of the screen in a clockwise direction.  Select this transition type by selecting the “Spiral In” button in the “Block 
Direction” group. 
 

S P I R A L  O U T  

The blocks that make up the new page start to appear in the center of the screen.  These blocks are added to the screen in a Spiral Out 
pattern towards the edges of the screen in a clockwise direction.  Select this transition type by selecting the “Spiral Out” button in the 
“Block Direction” group. 
 

S C A N  

The blocks that make up the new page start to appear at the position specified by the Block Direction.  The blocks scan across the screen.  
When the other end of the screen is reached, the next row of blocks are drawn in the same direction as the previous row of blocks.  Select 
this transition type by selecting the “Scan” button in the “Reveal Type” group.  Select the starting point and scan direction from the 
“Block Direction” group.  The starting points to choose from are: 
 

The blocks start to appear in the upper left corner of the screen.  Each row of blocks scan left to right/ bottom to top.  
This continues until the blocks fill in to the Lower Right corner. 
 
The first row of blocks appear at the top of the screen.  Each row of blocks scan left to right.  This continues until the blocks fill in 
to the bottom of the screen. 

 

The blocks start to appear in the upper right corner of the screen.  Each row of blocks scan left to right/top to bottom.  This 
continues until the blocks fill in to the Lower Left corner. 

 

The first row of blocks appear at the left side of the screen.  Each row of blocks scan top to bottom.  This continues until the 
blocks fill in to the right side of the screen. 

 

The first row of blocks appear at the right side of the screen.  Each row of blocks scan top to bottom.  This continues until the 
blocks fill in to the left side of the screen. 

 

The blocks start to appear in the lower left corner of the screen.  Each row of blocks scan left to right/top to bottom.  
This continues until the blocks fill in to the Upper Right corner. 
 
The first row of blocks appear at the bottom of the screen.  Each row of blocks scan left to right.  This continues until the blocks 
fill in to the top of the screen. 

 
The blocks start to appear in the lower right corner of the screen.  Each row of blocks scan left to right/top to bottom.  
This continues until the blocks fill in to the Upper Left corner. 
 
 

From Upper Left 
Corner 
From Top to 
Bottom 

From Upper Right 
Corner 

From Left to Right 

From Right to Left 

From Lower Left 
Corner 
From Bottom to 
Top 

From Lower Right 
Corner 
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Z I G Z A G  

These transition types are similar to the Block Scan transition types.  The main difference is, each row of blocks appears in a zigzag pattern.  
When a row of blocks are drawn, the next row of blocks are drawn in the opposite direction.  Select this transition type by selecting the 
“Zig Zag” button in the “Reveal Type” group.  Select the starting point and scan direction from the “Block Direction” group. 

 
B L O C K  S I Z E S  

The user can choose between three sizes of the blocks that make up the new page.  These are: 
 

The screen is divided up into 4332 blocks.  76 blocks horizontally by 57 blocks vertically. 
 

The screen is divided up into 972 blocks, 36 blocks horizontally by 27 blocks vertically. 

 

The screen is divided up into 300 blocks, 20 blocks horizontally by 15 blocks vertically. 

 

Small 

Medium 

Large 
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Select the block size from the “Block Size” group of buttons.  The size of the block does not affect the Transition Duration.  The smaller 
blocks are just displayed at a higher rate than the larger blocks. 
 
Select the desired block transition and the selected Block Transition type will appear in the Page Transition Type box. 
 
Iris Transitions 
When “Iris...” is selected from the Page Transition Type control, the Iris Transitions window (shown below) will appear. 
 

 
Iris Transitions window 

 
 
This window lets you select the various iris transitions.  To select an Iris Transition, select “Open” or “Close” from the “Iris” group, and 
select the position from the “Iris Position” Group.  Once selected, the selected Iris Transition will appear in the Page Transition Type drop 
down box.  There are a total of 18 Iris Transitions, (9 Open and 9 Close). 
 
When a page is displayed with an “Iris Open” transition, a rectangular iris appears at the Iris Position.  This iris opens to display the new 
page.  With an “Iris Close” transition, a rectangular iris appears around the entire old page and closes towards the Iris Position.  This makes 
the old page disappear and uncovers the new page. 
 
Each Iris transition can happen at any of 9 positions on the screen.  These positions are described here: 
 

U P P E R  L E F T  C O R N E R  

A rectangular iris appears in the Upper Left Corner of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the Upper Left Corner of the screen.  As 
the iris closes, the old page disappears and uncovers the new page. 

 

Open:  
Close:  
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T O P  O F  S C R E E N  

A rectangular iris appears in the middle of the top of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the middle of the top of the screen.  As 
the iris closes, the old page disappears and uncovers the new page. 

 
U P P E R  R I G H T  C O R N E R  

A rectangular iris appears in the Upper Right Corner of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the Upper Right Corner of the screen.  As 
the iris closes, the old page disappears and uncovers the new page. 

 
L E F T  S I D E  O F  S C R E E N  

A rectangular iris appears in the middle of the left side of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the middle of the left side of the screen.  
As the iris closes, the old page disappears and uncovers the new page. 

 
C E N T E R  O F  S C R E E N  

A rectangular iris appears in the center of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the center of the left side of the screen.  
As the iris closes, the old page disappears and uncovers the new page. 

 

Open:  
Close:  

Open:  
Close:  

Open:  
Close:  

Open:  
Close:  
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R I G H T  S I D E  O F  S C R E E N  

A rectangular iris appears in the middle of the right side of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the middle of the right side of the screen.  
As the iris closes, the old page disappears and uncovers the new page. 

 
L O W E R  L E F T  C O R N E R  

A rectangular iris appears in the Lower Left Corner of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the Lower Left Corner of the screen.  As 
the iris closes, the old page disappears and uncovers the new page. 

 
B O T T O M  O F  S C R E E N  

A rectangular iris appears in the middle of the bottom of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the middle of the bottom of the screen.  
As the iris closes, the old page disappears and uncovers the new page. 

 
L O W E R  R I G H T  C O R N E R  

A rectangular iris appears in the Lower Right Corner of the screen and opens up to display the new page. 
A rectangular iris appears around the old page and closes towards the Lower Right Corner of the screen.  As 
the iris closes, the old page disappears and uncovers the new page. 

 
Sparkle 

When a page is displayed with a sparkle, each scanline of the new page appears in a random order.  Each scanline from the new 
page replaces a scanline of the old page. 

 

Open:  
Close:  

Open:  
Close:  

Open:  
Close:  

Open:  
Close:  
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Page Templates 
 
Many users like to have a common look to their titles.  Whether it is for their entire facility, or a unique "look" for each client.  A Page 
Template can be created with the desired style.  A page template has "Template Fields" at different positions on the page.  When the Page 
Template is opened, a window appears that prompts you to enter the text for each field.  Once the text is entered, the page is automatically 
created using the style of the Template and the text that was entered in the Template Fields. 
 
Templates are controlled in two different parts of the User Interface.  These are the Template Gallery and the Text Substitution Tab.  The 
Template Gallery is used to create, open, and save page Templates.  The Text Substitution Tab is used to place and assign names to the 
Template Fields. 
 
Template Gallery 
The Template Gallery is on the right hand side of the User Interface with the Text Style Gallery.  The "Page Templates" tab displays all of 
the Templates that are on your system.  If more Templates exist than will fit in this window, you can scroll through them using the scroll 
bar at the bottom of the Template Gallery. 
 
Left Clicking on the Picon of one of the Page Templates will open the clicked Page Template so that it can be used to create a title page.  
This will display the "Enter Template Field Text" window.  This window will be discussed later in the section titled "Creating a New Page 
with a Template". 
 
Right Clicking on one of the Picons will display the Page Template menu shown below: 
 

 
Page Template Menu 

 
This menu can also be displayed by selecting the "Manage Page Templates" entry from the "File" menu. 

Chapter 
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New Page Template 
Selecting the "New Page Template" entry from the "Page Template Menu" will create a new Page Template.  When this entry is selected, 
the following window will appear: 
 

 
New Template Name Window 

 
Enter the name of the Page Template that you want to create and press the "OK" button.  Use the normal editing functions and the Text 
Substitution tab to create the Page Template.  Remember to save this new page as a Page Template and not as a normal page. 
 
Edit Page Template 
Selecting the "Edit Page Template" entry from the "Page Template Menu" will open an existing Page Template so that you can make 
changes to it.  Use the normal editing functions and the Text Substitution tab to edit the Page Template.  Remember to save this page as a 
Page Template and not as a normal page. 
 
The behavior on this function is different depending on which menu it was selected from.  If it was selected from the Main Menu, a 
window will appear that prompts you to select which Page Template you want to edit.  If this menu entry is selected from the popup menu 
that appears when you right click the Picon of a Page Template, the Template that was clicked on will automatically be selected as the 
Template to edit. 
 
Open Page Template 
Selecting the "Open Page Template" entry from the "Page Template Menu" will open an existing Page Template so that it can be used to 
create a title page.  This will display the "Enter Template Field Text" window.  This window will be discussed in the section titled "Creating 
a New page with a Template". 
 
The behavior on this function is different depending on which menu it was selected from.  If it was selected from the Main Menu, a 
window will appear that prompts you to select which Page Template you want to open.  If this menu entry is selected from the popup 
menu that appears when you right click the Picon of a Page Template, the Template that was clicked on will automatically be selected as the 
Template to open (just like left clicking on it). 
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Save Page Template 
Selecting the "Save Page Template" entry from the "Page Template Menu" is used to save the current page or Template as a Page Template.  
When this entry is selected, the following window will appear: 
 

 
Save the Page Template Window 

 
If the current page is a Page Template, the name of the current Page Template will appear in the "Page Template Name".  Enter the name 
that you want to save the Template as, and press the "Save" button. 
 
Delete Page Template 
Selecting the "Delete Page Template" entry from the "Page Template Menu" will delete the current Page Template.  As a safety precaution, 
the Page Template must be opened before it can be deleted.  Otherwise this entry will be disabled until you open the Page Template that 
you want to delete. 
 
Text Substitution Tab 
Once a Page Template has been created or opened for editing, the Text Substitution Tab can be used to add and change Template Fields.  
The Text Substitution Tab is at the bottom of the User Interface along with all of the other tabs.  When the Text Substitution Tab is 
selected, it will appear as shown below: 
 

 
Text Substitution Tab 
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Substitution Variables 
Substitution variables are used to display data that may change from time to time.  These can be things like Temperature, Vote Counts, 
Sports Scores, or any other data that you may want to automatically update.  To enable this feature you must have an optional plug in that 
may be purchased from Datavideo, Third Party Vendors, or you can write your own.  For more information contact Datavideo. 
 
If substitution variables are enabled on your system, the controls for these will be displayed.  To add a variable to a page, move the cursor 
to the desired position and press the "Add New Variable" button.  The value of the first variable in the list will appear on the screen and the 
Variable selection box will be enabled.  Select the variable that you want displayed at this position and its value will appear.  The variable will 
be displayed with its current value (such as current temperature) whenever this page is displayed. 
 
Variables on a page are treated as single characters.  When you place the cursor over a variable, it will appear over all of the characters in the 
variable and the name of the current variable will appear in the Variable selection box.  Any changes to the text attributes of a variable will 
be applied to all characters of the variable. 
 
Page Template Fields 
The controls for the Template Fields are in the box labeled "Page Template Fields".  To add a Template Field to a page, move the cursor to 
the desired position and press the "Add a New Template Field" button.  When this is done the "Template Field Editor" window will appear 
as shown below. 
 

 
Template Field Editor 

 
The Template Field Name is the name that will be used when the user is prompted to enter the text for the Template Field.  The Default 
Text will appear in the  “Enter Template Field Text Window” when the Page Template is opened.  The Default Text will also appear in the 
Picon for the Page Template at the assigned position of the Template Field.   
 
Enter the name of the Template Field along with the Default Text for the new field and press the “OK” button. 
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Each Template Field is treated as a single character.  When you place the cursor over a Template Field, it will appear over all of the 
characters in the field.  Any changes to the text attributes of a Template Field will be applied to all characters of the field. 
 
When the cursor is placed on a Template Field the "Edit Template Field" button will be enabled.  Pressing this button will display the 
"Template Field Editor" so that the Template Field name and Default Text can be changed. 
 
Field and Variable Positioning 
When the text changes on a page, the new characters may be wider or narrower than the Default Text.  If you position the text on the 
screen using the Default Text as a reference, the new text may no longer be lined up the same way as the old text.  On the right side of the 
"Text Substitution" tab are some buttons used to control the positioning of the new text.  They are all in the box labeled "After 
Substitution is Made:".  These buttons determine how the positioning should be modified after the text of the Template Field has been 
changed. 
 
This value can be set independently for each Template Field and Variable. 
 
Creating a New Page with a Template 
When a Page Template is used to create a page, (either by clicking on it in the Template Gallery or by selecting "Open Page Template" from 
the menu) a window similar to the following is displayed:  
 

 
Enter Template Field Text Window 

 
This window displays the name and default text of all the Template Fields that are in the Page Template.  Enter the text that you want for 
each Field and press the "OK" button.  The page will automatically be created with the entered text.  You can now make any modifications 
to the page before you save it as a normal title page. 
 
Keep in mind that each Template Field will be treated as a single character until the page has been saved as a normal page, and then 
recalled.  After the new page has been opened again, you can manipulate each character of the Template Field separately. 
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Text Animation 
 
Up to 1000 layers can be created on each page.  Text FX can animate each of these layers independently from each other.  Text Animation 
is done using keyframes.  These keyframes let you crop, move, and resize each layer.  The fade and blur levels of the layer can also be set in 
the keyframe.  Multiple keyframes can be set for each layer.  If the keyframes are different at different positions in the timeline, the in 
between frames will be created automatically by interpolating the settings from the keyframes.  This creates smooth animation sequences. 
 
There are three main steps to creating a Text FX animation.  These are compose the layers, define the motion paths, and render the 
sequence. 
 
Composing text is just like creating a normal title page, except that any text that you want to move separately from the other text should be 
placed on separate layers.  With the time line displayed you can create keyframes to define the motion paths.  Most of this chapter is 
devoted to creating Keyframes to define the motion paths. 
 
Once the motion paths have been defined, the text animation sequence is now ready to be rendered.  The Animation Sequence can be 
rendered as a sequence of TGA images or as a Video Clip. 
 
Overview 
There are two windows that you will use to define the motion paths of the various layers.  These are the Timeline and the Keyframe Editor.   
 
The Timeline shows each layer of the page.  Each layer has its own line on the timeline where the keyframes that you create for each layer 
are placed. 
 
The Keyframe Editor is used to select which portion of the layer to display (cropping), set the size and position of the layer, and also 
control the Fade and Blur levels of the layer. 
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Timeline 
Once the page has been composed with the various layers, press the "Text FX" button to display the Timeline. 
 

 
Timeline Window 

 
The timeline window is divided into three sections.  These are the Time Ruler, Timeline, and Preview Windows. 
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Time Ruler 
The top section is the Time Ruler.  The Time Ruler performs two functions.  The first function is to serve as a ruler to indicate at which 
time during the Animation Sequence where each keyframe will be placed.  The second function is to allow you to preview the text 
animation.  If you click on the Time Ruler and drag the mouse, the animation sequence will display at each position that the mouse is 
dragged across.  This gives the effect of "Playing" the animation sequence.  If you drag the mouse to the left, the animation sequence will 
play backwards. 
 
The Time Ruler is marked off in percentages instead of frames or seconds.  This keeps the animation from being "locked into" a certain 
duration.  The duration is specified when the animation is rendered.  If the animation plays too fast, you can increase the duration.  If it 
plays too slow, you can decrease the duration. 
 
Timeline 
The left side of the Timeline lists each layer of the page.  The layers are listed in their display priority.  The very top layer listed on the 
timeline will be the layer that is in front of all of the other layers.  The bottom later is the one that is behind all of the other layers.  The right 
side of the timeline (under the Time Ruler) shows where keyframes are positioned for each layer.  Keyframes on the left (at the 0% 
position) specify the appearance at the beginning of the animation.  Keyframes on the right (at the 100% position) sets the appearance at 
the end of the animation.  Setting the keyframes at any other position on the timeline will set an intermediate keyframe. 
 
A small green box will appear at every position on the timeline where a keyframe is set.  A small red rectangle indicates the current cursor 
position in the timeline.  The current cursor position is also indicated in the "Layer" and "Position" sections of the status bar. 
 
Preview Window 
The preview window lets you preview what the page will look like at each point in the animation sequence.  The left display shows just what 
the layer looks like at the current time position.  The right display shows what the page looks like at the current time position when all layers 
are combined. 
 
The preview window also has two buttons.  Pressing the "Modify Keyframe" button will allow you to modify (by displaying the Keyframe 
Editor window) the keyframe at the current cursor position.  If a keyframe is not already defined at the position, one will be created.  When 
you have finished adding keyframes to define the motion paths, press the "Done" button to return to the normal page composition mode. 
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Keyframe Editor Window 
When you are adding or modifying a keyframe, the Keyframe Editor window (shown below) will appear. 
 

 
Keyframe Editor Window 

 
Use this window to control how the layer will appear at this position in the animation sequence.  You can vary the cropping, size, and 
position of the layer, as well as the blur and fade levels. 
 
The left display screen shows the layer at normal size.  This screen is used to select which portion of the layer to display (cropping).  The 
right display screen is used to set the size and position of the selected portion of the layer.  If the box in the right screen is larger than the 
box in the left screen, the layer will be displayed larger than the original size.  If the box on the right screen is smaller than the box on the 
left screen, the layer will be displayed smaller than the original size.  There are also four buttons to select which other layers you want to 
preview this layer with. 
 
This window also has two sliders.  These sliders are used to set the fade level and the blur level for the layer at this point in the sequence. 
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The Basics 
A keyframe determines how the layer will appear.  The keyframe’s position in the timeline determines at which point during the animation 
sequence it will appear this way.  When the animation sequence is rendered, the program will automatically create the intermediate frames 
by interpolating from the keyframes (before and after) each intermediate frame.  This is how animation sequences are created. 
 
Now we get to learn how to use these windows to manipulate the keyframes to create motion paths for all of the layers on the page. 
 
The Timeline 
The Timeline (shown below) is where we create, position, move, copy, and delete keyframes.  The left side of the timeline lists all of the 
layers that are on the page.  To the right of each layer name (below the time ruler) is an area where keyframes are placed. 
 

 
Timeline Window 

 
When a keyframe is placed on the timeline, it appears as a small green box.  The timeline also has a small red rectangle (cursor) to indicate 
the current cursor position.  The cursor is used to select the current layer and time position.  The current cursor position is also indicated 
on the status bar. 
 
The cursor can be moved by using the cursor movement keys (Up, Down, Left, Right, Home, End, PgUp, and PgDn).  It can also be 
moved by placing the mouse over the desired position and clicking the left mouse button. 
 
Moving the cursor vertically will select a different layer.  The layer that the cursor is on appears on the left screen in the preview window.  
Moving the cursor horizontally will change the time position.  When the time position is changed, both screens in the preview window will 
be updated to show how the page will appear at this point in the animation sequence. 
 
Adding a Keyframe 
The easiest way to add a keyframe to the timeline is to position the mouse over the desired position and double-click the left mouse button.  
When this is done a new keyframe is added to the timeline and the keyframe editor window is displayed so that the new keyframe can be 
modified.  We will discuss the keyframe editor window later in this chapter. 
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A keyframe can also be added to the timeline at the current cursor position by pressing the <Ins> key. 
 
Modifying a Keyframe 
An existing keyframe can be modified by positioning the mouse over the green box that represents the keyframe and double-clicking the 
left mouse button.  When this is done the keyframe editor window is displayed so that you can change the keyframe’s settings. 
 
The keyframe can also be modified by positioning the cursor over the keyframe and pressing the <Enter> key. 
 
Moving a Keyframe 
To change the position of a keyframe, place the mouse over the keyframe to be moved, press and hold down the left mouse button, then 
drag the keyframe to its new position.  Once the keyframe is at the desired position, release the left mouse button. 
 
Copying a Keyframe 
Copying a keyframe is very similar to moving a keyframe.  If you hold down the <Ctrl> key while dragging the keyframe to the new 
position, the keyframe will be copied to the new position instead of moved.  The original keyframe will remain where it was. 
 
Deleting a Keyframe 
A keyframe is deleted from the timeline by positioning the cursor over the keyframe to be deleted and pressing the <Del> key. 
 
Cut, Copy, and Paste Keyframes 
Keyframes can be cut and copied to the clipboard using the cut and copy commands in the edit menu or by using the normal shortcut keys 
(<Ctrl+X> and <Ctrl+C>).  Position the cursor over the keyframe that you want to place into the clipboard and use the appropriate 
command.  Using the copy command (Crtl+C) will place the keyframe in the clipboard but will leave it in the timeline.  Using the cut 
command (Crtl+X) will remove the keyframe from the timeline. 
 
Once a keyframe has been placed into the clipboard, it can be pasted into the timeline.  Position the cursor where you want the keyframe to 
be added and use the paste command from the edit menu or the normal shortcut keys (Crtl+V).  This will copy the keyframe from the 
clipboard into the timeline. 
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Previewing the Animation Sequence 
The animation sequence can be previewed by clicking the mouse on the Time Ruler and dragging it.  As the mouse is dragged horizontally 
across the Time Ruler, both screens in the preview window will be updated to show how the page will appear at this point in the animation 
sequence.  Dragging the mouse to the right will preview the sequence forward.  Dragging the mouse to the left will preview the sequence 
backwards.  The Animation Sequence can also be previewed using the <Æ> and <> cursor controls keys. 
 
Keyframe editor 
The Keyframe Editor Window (shown below) has the controls that are used to define how the layer will appear at the selected position in 
the animation sequence.  You can vary the cropping, size, and position of the layer, as well as the blur and fade levels. 
 

 
Keyframe Editor 

The top of this window has two display screens.  The left screen is used to select the portion of layer to display (cropping).  The right 
screen is used to select the size and position of the text that is selected by the left window. 
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Cropping window 
The left screen shows the layer at its normal size.  A red rectangle appears around the portion of the layer that will be displayed.  This red 
rectangle has smaller rectangles attached to the corners, these are handles.  Clicking on one of these handles and dragging it to the new 
position can change the size of the selection rectangle.  Placing the mouse inside the rectangle, then clicking the mouse and dragging it to 
the desired position can move the entire rectangle.  Notice that while this rectangle is being changed, the right screen is automatically 
updated to show the current selection. 
 
Underneath the left screen are some numbers. These indicate the position of the Top, Bottom, Left, and Right sides of the rectangle.  
These values are automatically updated when the rectangle is moved.  You can also enter these numbers directly, or you can "fine tune" 
these numbers by using the increment and decrement buttons to the right of the number. 
 
There's also a "Full Screen" button.  Pressing this button automatically changes the selection rectangle to select the entire layer. 
 
Placement Window 
The right screen is used to select the size and position of the text that is selected by the left screen.  A red rectangle appears where the 
selected text will be displayed.  The position of this rectangle controls the position of the text; the size of this rectangle controls the size of 
the text.  This rectangle also has handles.  Clicking on one of these handles and dragging it to the new position can change the size/position 
rectangle.  Placing the mouse inside the rectangle, clicking the mouse, and dragging it to the desired position can move the entire rectangle.  
Notice that while this rectangle is being changed, the screen is automatically updated to show the selected text at the current size and 
position. 
 
Underneath the right screen are some numbers that indicate the position of the Top, Bottom, Left, and Right sides of the rectangle.  These 
values are automatically updated when the rectangle is moved.  You can also enter these numbers directly or you can "fine tune" these 
numbers by using the increment and decrement buttons to the right of the numbers. 
 
Below the right screen are three buttons (Full Screen, Original Size, and Original Position).  These buttons are used to easily set the 
rectangle size and position to common values.  Pressing the "Full Screen" button will display the selected text the full size of the screen.  
Pressing the "Original Size" button will display the selected text the same size as it is displayed on the left screen.  Pressing the "Original 
Position" button will display the selected text at the same position as it is on the left screen. 
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When positioning the text you may want to align it with text on other layers.  There are four buttons (Nothing, Background Video, 
Layers Behind, and All Layers) that allow you to select which other layers you want to preview the selected layer with.  Selecting 
"Nothing" will display only the selected text against a black background.  If you select "Background Video" the selected text will be 
displayed over the background video image.  If you want to see the selected text along with all of the layers that are behind it, press the 
"Layers Behind" button.  Pressing the "All Layers" button will display the selected text with all of the other layers on the page. 
 
Preserve Aspect Ratio 
Quite often you will want to change the size without distorting the image.  To do this the height and width must be changed by a 
proportional amount.  Sometimes this can be difficult.  If you select the "Preserve Aspect Ratio" mode by pressing the "Preserve 
Aspect Ratio" button the program will take care of this for you.  When in this mode changing the height of a rectangle will automatically 
change the width by the correct amount.  Changing the width of the rectangle will automatically change the height by the correct amount. 
 
Fade Level 
You can also control how much the layer is faded in or out.  The "Fade Level" slider is used to select this.  A fade level of 100% will 
display the layer at full intensity.  A fade level of 0% will display the layer completely faded out (not show it at all).  Any number in between 
will display the layer semi transparent. 
 
Blur Level 
The layer can also be de-focused using the "Blur Level" slider.  Setting the blur level to 0% will display the layer with its original sharpness.  
Increasing the blur level will make the layer appear blurred.  One note of caution: the more blurred you make the layer, the more time it 
takes to update the display.  Also, using very high levels of blur will increase the time it takes to render the animation sequence. 
 
When you're done editing the keyframe press the "OK" button.  Pressing the "Cancel" button will discard any changes that you made to 
this keyframe. 
 
Rendering 
Once the text has been composed and the motion paths defined, the animation sequence is now ready to be rendered.  It can be exported 
as a sequence of TGA images or as a Video Clip. 
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To render the text animation sequence, use the "Export Text Effects Animation" command from the Text FX’s "File" menu.  This can 
also be accomplished by pressing a little "Film Clip" button on the toolbar.  Select the folder, the filename, and the type of file that you 
want to use to save the animation sequence.  To render the animation sequence as a group of TGA images, select “TGA Sequence” as the 
file type.  To render it as a Video Clip, select “Video Clip” as the file type. 
 
If the animation sequence is rendered as a series of still images, a four-digit number will be appended to the end of the filename that you 
select.  For example, if you select the filename "TEMP" the first image in the sequence will be saved in the file "TEMP0000.TGA" the 
second image in the sequence will be saved in the file "TEMP0001.TGA" and so on. 
 
Once the folder and the filename have been selected the "Save Animation as a TGA Sequence" window or the “Save Animation as 
a Video Clip” window (both shown below) will appear.  This window lets you choose some optional settings before you start rendering. 

 

 

 
The first option is the four-digit number that is appended to the first image in the sequence.  This defaults to 0000 but can be set to any 
value.  When setting this value you should not make it so large that the last image file has a number larger than 9999. 
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The second option lets you set the length of the animation sequence.  This number is in frames.  If you are using NTSC (30 frames per 
second) and you want to make the animation sequence 10 seconds long, set this value to 300 frames. 
 
There are two check boxes (Save Alpha Channel and Compress TGA Images) that allow you to select the format that the TGA 
images are stored in.  If the "Save Alpha Channel" box is checked, 32-bit TGA images with an 8 bit alpha channel will be created.  If it is 
not checked, the sequence will be saved as 24 bit TGA images without an Alpha Channel.  Some systems can handle Run Length Encoded 
(RLE) compressed TGA images.  This can reduce the amount of disk space needed to hold the animation sequence.  If your system can 
handle RLE compressed TGA images, this box should be checked unless it slows down the system too much. 
 
Rendering Quality/Speed 
When rendering an animation sequence the processor must make many calculations to render the images at the highest quality.  This can 
take a lot of time to render.  There are also other ways of rendering that are faster but may not yield the highest quality images.  The 
program gives you three options.  The first option is "Fastest/Lowest Quality".  This is the quickest way to render an animation 
sequence, but gives you the lowest quality images.  The second option is "Medium".  This is a compromise between the highest quality 
rendering and the fastest rendering.  The last option is "Highest Quality/Slowest".  This mode yields the highest quality images, but this 
may take a long time to render. 
 
Frame/Field Based Rendering 
When the highest quality rendering is selected you are presented with another rendering option.  A drop-down list box appears so that you 
can select whether to do frame or field based rendering.   
 
There are two types of video, Interlaced and Non-Interlaced (Progressive scan).  NTSC, PAL, and SECAM video is all interlaced.  
Interlaced video consists of two fields that are displayed in two passes.  Each field contains every other scanline in the frame.  One field has 
the even numbered scanline; the other field has the odd numbered scanline.  Interlaced video displays the first field of alternating lines, and 
then displays the second field to fill in the gaps left by the first field.  When motion is displayed in interlaced video, the object may have 
moved between the time the first field was displayed and when the second field is displayed.  If this fact is not taken into account, the 
motion may not appear to be smooth. 
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To further complicate matters, some systems display the even scanline first while other systems display the odd scanline as the first field.  
So the program gives you two field rendering options (Field Order A and Field Order B).  As a general rule, if you are creating non-
interlaced video you should use frame based rendering.  If you are creating interlaced video you should use field based rendering.  Some 
experimenting may be necessary to select the proper setting for your system.  But once the proper setting is found, it should never change. 
 
The bottom of this window displays some information about the image files that will be rendered.  This includes the directory (folder) that 
the files will be stored in, the filename of the first image file, and the filename of the last image file.  It also displays the height and width (in 
pixels) of the image files that will be created. 
 
When you have selected the options that you want, press the "Render" button.  The "Save Animation as a TGA Sequence" window 
will change to show the rendering progress as well as an estimated time of how much longer the rendering should take.  To cancel the 
rendering press the "Cancel" button and rendering will stop.  When the rendering is complete, a message will appear telling you that the 
text animation sequence was created successfully. 
 
Rendering speed considerations 
One of the big advantages of using a program to do video effects instead of hardware is the fact that you don't have to spend a lot of 
money on specialized hardware.  One of the big disadvantages is that everything has to be rendered.  You can spend a lot of time waiting 
for animation sequences to render.  This section will give you some hints on how to reduce the amount of time you spend rendering. 
 
Processor Speed 
The most obvious way to speed up rendering is to use a faster processor.  I know, you're working with video, so you're probably already 
using the fastest processor(s) available. 
 
Make sure you have adequate RAM 
Windows uses virtual memory.  This means it can use more memory then is actually installed.  To do this its swaps memory that hasn't been 
used recently out to the hard disk.  Of course it takes time to do this.  So if your computer is doing a lot of memory swapping, it will slow 
down your entire system.  64 MB of RAM should be adequate to use Text FX.  However, if you're going to have other programs running at 
the same time you will probably need more. 
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Rendering Quality 
The program offers three rendering qualities.  The lowest quality renders much faster than the highest quality.  Many users use the lowest 
rendering quality when doing test renders (just checking to see how the animation will look).  Once they are satisfied with the animation 
sequence, they will then do a final render at the highest quality. 
 
Blur 
Blurring the video requires a large amount of computing.  The more blurred the layer, the more computation is required.  This can take a lot 
of time.  You should keep this in mind when doing test renders. 
 
Partial Screen 
Many times you'll just have a small amount of text on a layer.  When you define your keyframes, instead of animating the entire layer, select 
just the text.  This will save rendering time because the entire layer does not need to be calculated. 
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Modes, Settings, and Adjustments 
 
User Preferences 
The " Set User Preferences" dialog box is used to set preferences that may vary from one user to another.  To change the user 
preferences select the "User Preferences" command from the "Settings" menu.  When this is done the "Set User Preferences" 
dialog box (shown below) will appear. 
 

 
The set user preferences dialog box is made up of the following controls. 
 
Typeface/Logo/Texture Memory setting Used to set how much memory to use for the Typeface, Logos, and 

Textures buffer. 
Default Export Format Selects the file format of the graphic to be generated when the Export Page 

button is pressed  
Automatic Page Save mode Used to select the Automatic Page Save mode. 
Auto-Save Project Settings mode Used to select the Auto-Save Project Settings mode. 
Video Format Settings Selects the size of the Title Graphics to be created. 
 

Chapter 

14
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Typeface/Logo/Texture Memory Setting 
When the program starts, it allocates a block of memory that is used to hold Typefaces, Logos, and Textures.  This memory is also used to 
cache data that is needed temporarily when composing pages.  If you allocate more memory for this, you will be able to load more and 
bigger Typefaces, Logos, and Textures.  You will also get better performance from the program, but less memory will be available for other 
applications. 
 
If you are getting an error message such as "Typeface/Logo/Texture Memory full" you should increase this value. 
 
Default Export Format 
The program creates a Title Graphic whenever the Export Page button is pressed.  This Title Graphic has the same name as the page (of 
course the file extensions will be different).  This control lets you select the file format of this Title Graphic. 
 
The Title Graphic can also be exported to the Windows Clipboard.  When a Title Graphic has been exported to the clipboard, other 
graphic programs using the “Paste” function can use it. 
 
Automatic Page Save Mode 
The program can only have one page open at a time.  When you open a new page, the old page (or any changes made to it) will be 
discarded unless it is saved to disk.  When you open a new page, or exit the program, the current page can automatically be saved to disk if 
it was changed. 
 

A L W A Y S  A U T O M A T I C A L L Y  S A V E  

This setting will automatically save the page to disk (overwriting the original) without prompting you.  Use this setting with caution.  Any 
changes you make to the page will be saved to disk.  You won’t have the option of discarding the changes that were made. 
 

A L W A Y S  A S K  F I R S T  

This setting will ask your permission before saving the page to disk.  If the page has not been modified, you will not be asked if you want to 
save it.   
 

N E V E R  A U T O M A T I C A L L Y  S A V E  

This setting will never automatically save the page.  The program will not display the "Automatically Save Pages" window when you 
open a new page. 
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Auto-Save Project Settings mode 
Various settings are saved with the Project Settings in the project file.  This file has the same name as the project with a .SET extension 
(for example, the project MY_PROJECT would be defined in a file called MY_PROJECT.SET).  This file contains the following default 
settings: 
 
1. Character Attributes 
2. Style Gallery 
3. Color Gradients 
4. Default Color Palette 
5. Loaded Typefaces 
6. Loaded Textures 
7. Default Directories/Folders 
8. Safetitle Margins 
9. Tab Settings 
 
When a new project is opened, or the program is exited, any changes that you have made to these settings will be discarded unless the 
project settings have been saved.  These controls let you select whether or not to automatically save the project settings. 
 

A L W A Y S  A U T O M A T I C A L L Y  S A V E  

This setting will automatically save the current project settings to the project file without prompting you.  Use this setting with caution.  
Any changes you make to the current settings will be saved.  You don't have the option of discarding the changes. 
 

A L W A Y S  A S K  F I R S T  

This setting will ask your permission before saving the current project settings. 
 

N E V E R  A U T O M A T I C A L L Y  S A V E  

This setting will never automatically save the project settings.  You must use the “Save Project Settings” entry from the “File” menu to 
save any changes that were made to the current project settings. 
 



C H A P T E R  1 4  -  M O D E S ,  S E T T I N G S ,  A N D  A D J U S T M E N T S  

 120

Video Format Settings 
The values in “Video Format Settings” indicate the display resolution that the program is currently configured for.  Some Display Cards 
control the Video Format; other cards expect the program to determine the Video Format.  Pressing the “Change Video Format” button 
will display the “Select Video Format” window (shown below). 
 

 
Select Video Format Window 

 
This window lists the standard Video Formats.  If you have a High Definition (HD) version of the program, the “HDTV” selections will be 
enabled.  When a standard Video Format is selected, the program configures itself with the required display resolution and pixel aspect ratio 
(square or rectangular).  If none of the standard formats suit your needs, you can select a “Custom” format.  When this button is checked 
you can enter the desired display resolution.  The “Custom” format will create square pixels. 
 
The program must be restarted before the Video Format changes will take effect.  You will be reminded of this by displaying the “Video 
Format Changed” Window (shown below).  Press “Yes” to restart the program. 
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Video Format Changed Window 

 
Setting up Tabs 
The program can set up to 16 tabs per page.  The tabs specify horizontal positions of the screen that are used to align columnar text.  The 
tab positions are stored with the page.  When a page is opened, the tab positions will be set to those that the page was created with. 
 
To add, remove, or reposition a tab, or to enable or disable the tab display, select the "Set Up Tabs" command from the "Settings" 
menu.  This will display the “Set Up Tabs” dialog box (shown below). 
 

 
 
Display Tab Positions 
The Tab Display shows the positions of the tabs that are currently set.  If the tab display is enabled, vertical lines will appear the full height 
of the screen.  Each one of these vertical lines shows the position of a tab that is currently set.  Clicking the "Display Tab Positions" 
check box will toggle the state of the Tab Display.  If the Tab Display is on (signified by a check mark), this will turn it off. 
 
Markers in the set up tabs window  (below the title compose window) also shows the current tab positions.  These markers are displayed 
regardless of the "Display Tab Positions" setting.  Let's call this window the "Tab Markers Window". 
 
Once the tabs have been set up, they can be saved as the default tab settings in a project. 
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Set a New Tab 
The Tab Markers window displays all of the tabs that are currently set.  To set a new tab, position the mouse in the Tab Markers window at 
the position that you want the new tab and click the left mouse button.  A new marker will appear at the mouse position to indicate the 
position of the new tab. 
 
Move a Tab 
To move (reposition) an existing tab, position the mouse over the Marker that you want to move and drag it to the desired position.  Any 
text that is on the page will be redrawn to reflect the new tab position. 
 
Delete a Tab 
To delete an existing tab, select the marker that you want to delete by moving the mouse over it and pressing the left mouse button.  The 
marker will turn red to indicate that it is selected.  Press the "Delete Tab" button.  The selected marker will be deleted. 
 
Safetitle Margins 
When transmitting a video signal to a large number of televisions, many of those televisions will not be properly adjusted.  If you create a 
full page of text and try to view it on one of these televisions, the text may be cut off on the left, right, top, or bottom of the screen.  When 
you broadcast text, you normally want everyone to be able to read it (especially if you are trying to sell them a new TV). 
 
To solve this problem we define margins that it is safe to title within.  The margins are set by the factory to be at the recommended 10% 
height and width positions of the screen.  You can change these margin positions.  To do this select the "Safetitle Margins" command 
from the "Settings" menu.  When this is done the Safetitle margins dialog box (shown below) will appear.   
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Use the "Display Safetitle Margins" check box to hide or display the Safetitle margins on the screen.  The Safetitle margins are displayed 
on the screen whenever the "Safetitle Margins" window is displayed, regardless of the state of the "Display Safetitle Margins" check 
box. 
 
If you keep your text within this box it will be in the Safetitle area.  Use the arrow buttons to move the Safetitle margins.  Each margin (top, 
bottom, left, and right) has two buttons that are used to move them. 
 

 

 
Moves the margin up one scanline. 

 
Moves the margin left one pixel. 

 

 
Moves the margin down one scanline. 

 
Moves the margin right one pixel. 

 
You can also set the margin positions by entering a value directly. 
 
To set the margins to the recommended 10 percent height and width positions of the screen, press the "Default" button. 
 
Once the Safetitle margins are adjusted, press the “Done” button.  This will remove the dialog box from screen.  The Safetitle settings are 
saved as one of the project settings. 
 
Lower Third Mode 
While titling an image, you will quite often want to keep the titles in the Lower Third position of the screen.  To do this, without needing to 
re-position every page, set the system to Lower Third mode.  This moves the top margin (as well as the page text) to the Lower Third 
position.  Any pages composed in this mode will appear in the Lower Third portion of the screen.  Centering a page in this mode will center 
it in the Lower Third area. 
 
To change the Lower Third mode select the "Lower Third Mode" command from the "Settings" menu.  If the system is already in 
Lower Third mode, the Lower Third mode will be turned off.  You can also toggle the Lower Third mode by holding down the <Ctrl> key 
while pressing the <T> key.   
 
The current lower third mode can be saved as one of the default project settings. 
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Default Directories 
The program allows you to put any file in any directory on any disk.  This often results in files that you can never find again.  It is best to 
keep files of the same type (or the same project) in the same directory.  Default directories are a big help here.  The system allows you to set 
default directories for the different file types.  The default directories, and the type of files that default to these directories, are shown below. 
 
Page Directory 
The pages for the current project. 
 
Exported Graphics 
Graphic images that are exported when you press the "Export Page" button. 
 
Imported Graphics 
Where the program will look for Background Images if they are not found in their original location. 
 
Typeface Directory 
Typefaces 
 
Page Templates 
Where the Page Templates should be stored.  They will only appear in the Page Template Gallery if they are stored in this directory. 
 
Temporary 
This is the directory that the program will use for any temporary files that it needs to create. 
 



C H A P T E R  1 4  -  M O D E S ,  S E T T I N G S ,  A N D  A D J U S T M E N T S  

 125

To change the default directories, select the "Default Directories" command from the "Settings” menu.  When this is done the “Default 
Directories” Dialog box (shown below) will appear. 
 

 
 
This dialog box displays the default directories and their current settings.  The path can be entered directly, or you can browse for the 
desired directory. 
 
To enter a path directly, select the default directory entry that you want to change, and type in the full drive and path.  This should be in a 
form such as C:\PATH.  When you directly enter a default directory, you must make sure that the path exists on the specified drive. 
 
To browse for the desired directory, press the "Browse" button next to the directory that you want to change.  When this is done the 
“Select Directory” dialog box (shown below) will appear. 
 

 
 
Use this dialog box to select the new default directory.  The controls in this dialog box do the following: 
 

D I R E C T O R I E S  L I S T  
Use this control to select the default directory. 
 

D R I V E S  
Selects the drive that contains the desired default directory. 
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O K  B U T T O N  
Press this button when the directory is selected. 
 

C A N C E L  B U T T O N  
Press this button to cancel the directory selection. 
 
When you are done selecting the default directories, press the "OK" button in the default directories dialog box.  If you want to cancel the 
changes you have made, press the "Cancel" button. 
 
Once the new default directories are selected they must be saved as part of the project settings.  Otherwise, they will revert to the old 
settings when the project is opened again. 
 
Modifying the Color Palette 
To modify the color palette, the color palette must be displayed.  You can display the color palette by selecting the "Colors" tab in the 
Control Tabs Window and then pressing the "Palette" button.  Position the mouse over the color palette entry that you want to change 
and double-click it with the left mouse button.  When this is done the "Color Palette Editor" window (shown below) will be displayed. 
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The color palette editor has two methods of selecting a color.  You can use either the Color Picker or the Color Sliders.  The left side of 
this window shows a large sample of the current color selection.  To the right of the color sample, at the bottom of the window, is an 
Illegal Color Indicator.  If the selected color exceeds NTSC or PAL limitations, this indicator will appear red to indicate that you have 
selected an illegal color.  Otherwise this indicator will appear green. 
 
At the top of the screen, between the Color Sample and the Color Palette, are the Color Picker controls.  These controls include a 
"Hue Picker" and a "Color Picker Area".  The hue picker lets you select the hue (Red, Green, Blue, etc.) of the color.  Place the mouse 
over this control, and press the left mouse button to select the desired hue.  When the new hue is selected, the Color Sample, Color 
Picker Area, and the Color Sliders will be updated to reflect the new hue. 
 
Once the hue is selected you can now pick the color.  Place the mouse over the Color Picker Area and press the left mouse button.  This 
will select the color under the mouse.  If you hold down the left mouse button while the mouse is moved, the Color Sample and the 
Color Sliders will be updated to reflect the newly selected color. 
 
Below the Color Picker Controls and the Color Palette Display are the Color Sliders.  There are two numerical systems for defining colors.  
These are RGB (Red, Green, Blue), and HLS (Hue, Luminance, Saturation).  Both of these systems are used to define the same thing (like 
yards and meters).  You can use either set of sliders to adjust the color.  Changing one will automatically change the other. 
 
There are four ways to adjust the RGB, HLS, Transparency, and Background Video levels.  They can be adjusted by dragging the sliders.  
Double-clicking the number box and entering the new value with the keyboard can also adjust them.  To "fine tune" the levels, use the 
increment and decrement buttons.  The value will be increased or decreased by one each time you press one of these buttons.  These 
buttons will auto-repeat if you hold them down.  Clicking in the number box and dragging the mouse will also change the values. 
 
To the right of the Illegal Color Indicator is a "Transparent" button.  Pressing this button will set the transparency level to full (255).  This 
makes the color fully transparent.  Anything that you assign this color to will not be visible. 
 
To the right of the "Transparent" button is a "Background Video" button.  Pressing this button will set the background video level to 
full (255).  Anything that you assign this color to will be displayed using background video. 
 
To the right of the "Background Video" button is a "Pick Color From Screen" button.  Pressing this button will change the mouse 
cursor to look like an eyedropper.  Move the mouse to the position of the screen that you want to copy the color of, and press the left 
mouse button.  The color under the mouse will be selected. 
 
When you have selected the desired color for the color palette entry, you can select another color to modify from the color palette.  When 
you are done modifying the color palette, press the "OK" button and the Color Palette Editor window will close.   
 
Once the color palette has been modified, the changes must be saved as part of the project settings.  Otherwise, they will revert to the old 
settings when the project is opened again. 
 
Loading Textures 
The system has 16 slots that textures can be loaded into.  When you use a texture on a page, the page keeps track of which textures are 
needed to display the page.  If the textures that are loaded do not match the textures needed by the page, the correct textures will be 
automatically loaded. 
 
To load a new texture, the texture selection window must be displayed.  You can display the textures selection window by selecting the 
"Colors" tabs from the Control Tabs Window and then pressing the "Textures" button.  Position the mouse over the texture entry that 
you want to replace with the new texture and double-click it with the left mouse button.  When this is done the "Select Graphic Image 
to use as a Texture" window (shown below) will be displayed. 
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Select the graphic image that you want to load as a texture and press the "Open" button.  The selected image will then be loaded as a 
texture. 
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Building Color Gradients 
64 color gradients can be defined for each project.  To modify a color gradient, the color gradient selection window must be displayed.  You 
can display the color gradient selection window by selecting the "Colors" tab from the Control Tabs Window and then pressing the 
"Gradient" button.  Position the mouse over the gradient that you want to modify and double-click it with the left mouse button.  When 
this is done the color gradient builder (shown below) will be displayed. 
 

 
 
The color gradient builder has two major sections, the Color Selection section (on the right) and the Color Point Placement and Selection 
section (on the left).  The Color Selection section is used to select the color of each point in the color gradient.  The Color Point Placement 
and Selection section is used to select which point that you want to change the color of, and to change the position of the color points that 
make up the Gradient. 
 
The program can create two types of color gradients, Linear Gradients and Area Gradients.  A Linear Gradient can have as many as 16 
color points and can be rotated up to 90 degrees in either direction.  An Area Gradient can have either four (4) or five (5) color points.  A 
four-point color gradient lets you define a different color in each corner of the rectangle.  A five-point color gradient also lets you add a 5th 
color point inside the Area Gradient.  The 5th color point can be moved to any position inside the gradient. 
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The color point placement and selection section has two tabs.  One tab is used to edit Area Gradients and the other tab is used to edit 
Linear Gradients.  When the color gradient builder is first opened, the tab that corresponds to the type of gradient that you are editing is 
selected.  To change the color gradient to the other type just select the other tab. 
 
Area Gradients 
The “Area Gradient” tab (shown below) is used to edit area color gradients. 
 

 
 
The top portion of this window displays the current color gradient.  If it is a five-point color gradient, two markers will appear.  One marker 
above the gradient and one to the left of the gradient.  These indicate the position of the fifth point inside the gradient.  You can move the 
inside color point by dragging these markers.  You can also moved the inside color point by clicking at the desired position in the color 
gradient in this window. 
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The Corners group is used to select the color point(s) of the Area Gradient that you want to change the colors of.  If the color gradient is 
a 4 Point Area Gradient, four check boxes will be displayed representing each corner of the gradient.  If the color gradient is a five point 
Area Gradient, an extra check box will appear which represents the inside color point.  When a color point is selected, the box is marked.  
You can select more than one color point to be changed at a time.  When you select a different color (in the color selection section) all of 
the selected points will be updated to the new color.   
 
There are two buttons in the Spread Type Group that let you select whether this will be a 4 Point or a 5 Point color gradient.  If you select " 
5 point", the positioning markers will appear.  A center check box in the corners group will also appear. 
 
The "Apply Color to Selected Corners" button will set all of the selected color points to the current color. 
 
Linear Gradients 
The Linear Gradient tab (shown below) is used to edit Linear Color Gradients. 
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The Linear Gradient tab has three main controls.  The control on the left (let’s call it the Placement Control) displays the current position 
and color of each point on the Linear Gradient.  The top control displays the current Linear Color Gradient.  The bottom control (let’s call 
it the Angle Control) is used to set the angle of the Linear Color Gradient. 
 
The Placement Control shows positions and colors of the color points that are currently set.  A marker on the left side of the Placement 
Control represents each color point.  You can use this control to add a new color point, move an existing color point, delete a color point, 
or to select a color point to change the color of.   
 

S E T  A  N E W  C O L O R  P O I N T  

To set a new color point, position the mouse over the Placement Control where you want the new color point to be and press the left 
mouse button.  A new marker will appear at the mouse position to indicate the new color point. 
 

M O V E  A  C O L O R  P O I N T  

To move (reposition) an existing color point, position the mouse over the marker that you want to move and drag it to the desired position. 
 

D E L E T E  A  C O L O R  P O I N T  

To delete an existing color point, select the marker that you want to delete by moving the mouse over it and pressing the left mouse button.  
The marker will turn red to indicate that it is selected; all other non-selected markers will be blue.  Press the <Del> key on the keyboard, 
and the selected marker (and color point) will be deleted. 
 

C H A N G E  T H E  C O L O R  O F  A  C O L O R  P O I N T  

To change the color of a color point, select the color point that you want to change the color of, by moving the mouse over its’ marker and 
pressing the left mouse button.  The marker will turn red to indicate that it is selected.  Use the controls in the Color Selection section (on 
the right hand side) of the Color Gradient Builder. 
 

R O T A T I N G  A  L I N E A R  G R A D I E N T  

Use the angle control to rotate the Linear Gradient.  The angle control indicates the current rotation angle of the gradient with the line that 
is in the half circle.  If the gradient is vertical, the indicator line in the half circle will be vertical.  If the gradient is angled to the right, the 
indicator line will go off to the right, and so on.  You can rotate the Linear Gradient by clicking the mouse within the half circle.  You can 
also drag the rotation angle by dragging the indicator line back and forth.  As the rotation is changed the color Gradient Indicator (above 
the angle control) is redrawn to display the new angle of rotation. 
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Selecting a Color for the Color Point 
Once you have selected which point(s) that you want to change the color of, use the Color Selection controls (on the right hand side of the 
Color Gradient Builder) to select the new color.  The Color Gradient Builder has three methods of selecting a color.  You can use either 
the Color Picker, the Color Sliders, or the Color Palette.   
 
At the top of the screen, on the left-hand side of the color selection section, are the Color Picker controls.  These controls include a "Hue 
Picker" and a "Color Picker Area".  The hue picker lets you select the hue (Red, Green, Blue, etc.) of the color.  Place the mouse over 
this control, and press the left mouse button to select the desired hue.  When the new hue is selected, the Color Gradient, Color Picker 
Area, and Color Sliders will be updated to reflect the new hue. 
 
Once the hue is selected, you can now pick the color.  Place the mouse over the Color Picker Area and press the left mouse button.  This 
will select the color under the mouse.  The Color Gradient and the Color Sliders will be updated to reflect the newly selected color.  If you 
hold down the left mouse button while the mouse is moved, the color under the mouse will be selected as the mouse is moved. 
 
To the right of the Color Picker controls is the Color Palette.  The Color Palette has 64 preset colors.  Not all of the preset colors can be 
displayed at one time, so there is a scroll bar on the right hand side of the Color Palette.  Use the scroll bar to scroll through all of the preset 
colors.  To select a color from the Preset Color Palette, left click the desired color.  When a color is selected from the color palette, the 
Color Gradient, Color Picker Area, and the Color Sliders will be updated to reflect the new color. 
 
Below the Color Picker controls and the Color Palette display are the Color Sliders.  There are two numerical systems for defining colors.  
They are RGB (Red, Green, Blue) and HLS (Hue, Luminance, Saturation).  Both of the systems are used to define the same thing (like 
yards and meters).  You can use either set of sliders to adjust the color.  Adjusting one will automatically change the other. 
 
There are four ways to adjust the RGB, HLS, Transparency, and Background Video levels.  They can be adjusted by dragging sliders.  
Double-clicking the number box and entering the new value with the keyboard will also adjust them.  To "fine-tune" the levels, use the 
increment and decrement buttons.  The value will be increased or decreased by one each time you press one of these buttons.  These 
buttons will auto-repeat if you hold them down.  Clicking on the number box and dragging the mouse will also change the values. 
 
This section includes an Illegal Color Indicator to warn you if the selected color exceeds NTSC or PAL limitations.  The Illegal Color 
Indicator will appear red if you have selected an illegal color, otherwise it will appear green. 
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To the right of the Illegal Color Indicator is a "Transparent" button.  Pressing this button will set the transparency level to full (255).  This 
makes the color fully transparent.  This portion of the color gradient will not be visible.  You will see what is behind it on screen. 
 
To the right of the "Transparent" button is a "Background Video" button.  Pressing this button will set the Background Video level to 
full (255).  This portion of the color gradient will be displayed using Background Video. 
 
To the right of the "Background Video" button is a "Pick Color From Screen" button.  Pressing this button will change the mouse 
cursor to look like an eyedropper.  Move the mouse to the position of the screen that you want to copy the color of, and press the left 
mouse button.  The color under the mouse will be selected. 
 
Once you have finished changing the color of the selected color point(s), you can select another color point to change the color of. 
 

F I N A L  S T E P S  

When you are finished creating the new Color Gradient (or modifying an existing gradient) press the "OK" button and the Color Gradient 
Builder window will close.  Any changes to the color gradients must be saved as part of the project settings.  Otherwise they will revert to 
the old Color Gradients when the project is opened again. 
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Exiting the Title Composer 
 

Well, all good things must come to an end.  This is also true of manuals and of programs.  Manuals just sort of fade into the back cover.  
But programs need to be exited.   
 
When it’s time to exit the Title Composer, select the “Exit” command from the “File” menu.  The program will begin its shut down 
sequence.  The program can also be exited by holding down the <Alt> key while pressing <X>. 
 
Any page changes or settings changes that are not saved will be lost when you exit the program. 
 
If the page has been modified, and the “Automatically Save Pages” setting in the “User Preferences” dialog box requires it, the following 
message will appear. 
 

 
 

If you want to save the changes to the page, press the <Yes> button.  Otherwise press the <No> button and the changes will be discarded. 

Chapter 

15
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If the “Auto Save Project” setting mode is set to “Always ask First”, the program will display the following message box just before the 
program exits. 
 

 
 
This message box gives you the option of saving the current project settings before you exit. 
 
The current project settings include the following: 
 
1. Character, Edge, and Shadow attributes. 
2. Style Gallery 
3. Color Palette Settings. 
4. Color Gradients 
5. Loaded Typefaces 
6. Loaded Textures 
7. Typing mode 
8. Lower Third mode 
9. Default Directories 
10. Any changes that you made to the Safetitle Margins, and Tab Settings. 
 
Press <Yes> to save the project settings and exit the program.  If you save the settings they will be restored the next time you open the 
project.  Press <No> to exit the program without saving the settings. 
 
We hope you have enjoyed using the Title Composer. 
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Service and Support 
It is our goal to make your products ownership a satisfying experience. Our support team is available to assist you in setting up and 

operating your system. Please refer to our web site www.datavideo-tek.com for answers to common questions, support requests or contact 

your local office below. 

 

Datavideo Corporation (USA) 

12300-U East Washington Blvd., Whittier, CA 90606 USA 

Tel: +1 562 696 2324  contactus@datavideo.us www.datavideo.us 

 

Datavideo Technologies Europe BV 

Californiedreef 263565 BL Utrecht, The Netherlands 

Tel: +31 30 261 9656  info@datavideo.nl  www.datavideo.info 

  

Datavideo UK Limited 

Unit 2 Waterside Business Park, Hadfield, Glossop, Derbyshire SK13 1BE UK 

Tel: +44 1457 851000  sales@datavideo.co.uk  www.datavideo.info 

 

Datavideo Technologies Co., Ltd. 

10F, 176 Jian-Yi Rd, Chung Ho City, Taipei Hsien, Taiwan 235 

Tel: +886 2 8227 2888  info@datavideo.com.tw       www.datavideo.com.tw 

 

Datavideo Technologies China Co. 

2F-D, 2 Lane 777, West Guangzhong Rd, Zhabei District, Shanghai, China 

Tel: +86 21 5603 6599  service@datavideo.cn  www.datavideo.cn 

 

Datavideo Technologies (S) PTE Ltd. 

No. 100, Lorong 23 Geylong, #01-03 D’Centennial Bldg, Singapore 388398 

Tel: +65 6749 6866  info@datavideo.sg  www.datavideo.info 
 

Datavideo Hong Kong Ltd. 
G/F., 26 CROSS LANE, WANCHAI, HK 
Tel: +9485 3222   leon@datavideohk.com  www.datavideohk.com 
 
 
 
 
 
 
 

All the trademarks are the properties of their respective owners.  
Datavideo Technologies Co., Ltd. All rights reserved 2005.                                                       
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